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Introduction : Scope
1 Introduction
The Ramses MSC comes in two different chassis types and three models (8, 16 and 24 
faders) plus an optional Edit Bay and the ARC.

To aid understanding we have named the various Ramses panels:

• Fader Panel = per 8 faders

• EQ Panel = per 8 channels including Aux and Pan

• The Monitor Panel = Monitoring Section and Transport Bar

• The Expert Panel = Navigation, Automation, grouping. 

• The Upper Active Panel = System management, Active Screen (TFT Touch)

• The Lower Active Panel = Master routing Panel, quick transport and locators

• Meter Bridge = A Pyramix window which provides a Meter Bridge
for the Ramses MSC. This can be viewed on any
monitor connected to the Pyramix workstation.

Options

• Edit Bay = Pyramix Editor Remote including a Transport Bar 

• ARC = 48 Channels or 72 Channels depending on the
Ramses Chassis

Scope

This manual is written for Ramses Consolesoft version 1.5.3 3572 with firmware 1.5.2.31 in conjunction 
with Pyramix version 6.0 and although most of what is outlined here will be relevant to other versions of 
the software, please check to see if a more recent of this document exists on the Merging website.

Document Organisation
This document is organised mainly by control groupings, so if you are mystified as to the function of a given 
control, please refer to the chapter that describes the panel it is located on and then cross-reference the 
number printed on the panel image at the beginning of the chapter to locate the description for that control.

All Contents and Index entries and cross-references including the numbers referred to in the 
previous paragraph are hyperlinks. Just click on them to jump to the information.

Updating
Please refer to the Ramses MSC Software Upgrade Guide for detailed information on upgrading your 
firmware, Consolesoft and Edit Bay Sets.

Latest updates of Ramses and Pyramix
We strongly advise checking at: 

www.merging.com/ramses/download
 Introduction 1 - 8
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for the latest Pyramix and Ramses software and firmware versions or contacting your local merging Tech-
nologies Sales Partner who will help provide you with updates.

Other Documents
For a more task orientated, 'how to', manual, please refer to the Ramses Tutorial Guide.

http://www.merging.com/ramses/download/ 

Here you will also find further documents retaining to installing and operating RamsesMSC and Pyramix.

Terminology

In all Ramses MSC documentation we use the following terms:

Virtual Strip A mixer control Strip on the Pyramix Virtual Mixer that can be controlled and 
displayed by the physical controls on the Ramses MSC. Strip types include 
Inputs, Mix, Sub-Group and Aux Bus Masters and Control Groups.

Slot or Physical Control Strip
Each Slot is a vertical group of physical controls, including a fader, on the 
Ramses MSC surface.  You will have either 8,16 or 24 of these, depending on 
the model and configuration of your console.  A Slot can have any Virtual 
Strip selected to it.

Ergonomic Spread An arrangement of virtual Mixer Strips assigned to Slots.  Ergonomic 
Spreads can be stored, recalled, modified etc…

Touch (Screen) Button Refers to a Virtual Button. I.e. an area of the touch screen that must be 
touched to perform a function, not a hardware button.

Expert Panel Includes all controls concerned with Navigation, Automation, Copy/Paste 
of Settings, Grouping and Ergonomic Spreads.

Monitor Panel Monitoring Section and Transport Bar
Upper Active Panel System management, Active Screen (TFT Touch)
Lower Active Panel Master Routing Panel, Joystick Panner, Quick Transport and Locators
Iggy Is the name of the Ramses MSC software application and interface shown on 

Active Screen 
Consolesoft Files containg Iggy software
Firmware Files for programming Hardware upgrades (flash)
Consolesoft Sets Files containing Edit Bay mappings
 Introduction 1 - 9
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Panels

 FADER PANEL

EQ PANEL UPPER ACTIVE PANEL

LOWER ACTIVE PANEL

MONITOR PANEL

EXPERT PANEL

Ramses MSC Panels
 Introduction 1 - 10
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The Basics

How to turn your Ramses On
Assuming the Console has been correctly installed and is plugged into mains power,  simply press the 
black 'ON' button to power on the console. The switch can be found on the rear panel on the left-hand side 
when viewed from the back:

The boot process takes approximately one to two minutes.

How to turn your Ramses Off
Press the SYSTEM Button on the Upper Active Panel, then press the SHUTDOWN Touch Button then con-
firm by pressing the CONFIRM Touch Button.

How to load your project
Once your Ramses has booted, you will be able to load a project in Pyramix and start mixing.

Note: it is important that the console is fully powered up before you load your project.

The Pyramix project you load will determine the number and type of the features you will be able to map to 
your Ramses. For example, the number of  mixer strips, tracks and plugins, whether there is a monitoring 
section etc.

At any time you may add or remove strips, tracks, buses, plugins etc. and the Ramses will reconfigure in 
seconds.

Tips and tricks
We strongly recommend setting up some templates on your Pyramix/Masscore that include everything you 
need in your day to day work, since MassCore has tremendous power (256 I/O and 256 Busses). This will 
avoid the inconvenience of mixer rebuilds. Treat the Ramses as you would a normal, fixed architecture con-
sole with a full complement of Dynamics, EQ's and effects etc. and just switch the functions on as you need 
them.

POWER SWITCH

Power Switch
 Introduction 1 - 11
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2 Ramses Setup

Scope
Setting up a Ramses MSC is very simple. Once you have installed it and connected it with Pyramix we 
strongly advise you to work through this Setup section since every Ramses has specific features such as 
the number of faders, whether an Edit Bay is present etc.

Setting up Ramses with Pyramix
Please refer to the Ramses Install Guide available at:

www.merging.com/ramses/download

Upgrading Ramses Software and Firmware
Please refer to the Ramses Upgrade Guide available at:

www.merging.com/ramses/download
 Ramses Setup 2 - 12
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Setup
On the Upper Active Panel press the system button to access the System menu with the following 
choices. You can access the System menu at any time from any page by pressing the system button

Each Touch Button performs and action, displays information or opens the associated sub-menu. Where 
there are blanks, these are available for future expansion:

Active Screen - System Page

system button
 Ramses Setup 2 - 13
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Engines
Opens the Engines page. All engines currently installed are listed and can be restarted from here.

Stems
Description to follow.

Errors
Displays a log file in the unlikely event of errors.

Info
Lists all the software versions installed currently along with the sub-module versions specific to this con-
sole.

Configure
Opens the Configure sub-menu

Versions
Opens the Versions page. I.e. this is where you can load an alternative version of the ConsoleSoft appli-
cation or install a new one. Also where sets (configuration files) for the optional Edit Bay are installed and 
loaded.

Please see the Ramses MSC upgrade guide for details.

Firmware
Opens the Firmware page. All Firmware versions currently available in the console are listed and can be 
installed from here. Also, new versions of Firmware are imported into the console from this sub-menu.

Please see the Ramses MSC upgrade guide for details.

Network
Opens the Network page. This is where the Network connection is configured.

Please see the Ramses MSC install guide for details.
 Ramses Setup 2 - 14
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Shutdown
Initiates the Shutdown sequence for the console. The Confirm Touch Button appears. Press this to begin 
console Shutdown. 

Exit
Exits the System menu and returns to the screen displayed prior to entering the Setup menu.
 Ramses Setup 2 - 15
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Configure sub-menu
The Configure sub-menu has a number of pages. Pages are located by pressing the Next and Previous 
Touch Buttons. Since this is Page 1 only the Next button is available 

The name of the current page is shown in yellow at the top of the screen. The ~ symbol indicates that 
changes made on this page will only take effect after a console restart.

The available options are listed below in white.

The label in lilac at the bottom of the screen above the buttons indicates which parameter(s) can be changed and which physical controls may be used to change it. (In this case the Active Controls below the screen may be used to navigate the list)

Active Screen - Configure Page 1
 Ramses Setup 2 - 16
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Page 1 Page 2 Page 3
Pyramix 5 or 6 In most cases set this 
to V6 (MassCore)

Number of physical faders 8 - 16 - 24 ARC Option
- No ARC
- Arc 48
- Arc 72

Page 4 Page 5 Page 6
Hide Mouse Cursor within Iggy
- TRUE
- FALSE

Autosave time interval for Ramses 
templates
In minutes if not zero

Iggy Skin Version (appearance)
- 0 (not recommended)
- 1 (recommended)
 Ramses Setup 2 - 17
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Page 7 Page8 Page 9
Edit Bay configuration
0 is default
1 - 9 are User Sets

Engine IP address = Pyramix IP 
address
System > Network shows Ramses IP 
address

Sets the time after last jog event after 
which jog is canceled and Stop 
invoked
0 - disable
1 - X seconds

Page 10 Page 11 Page 12
Scene Mode for Theatre Use
(future implementation)
- FALSE
- TRUE

Change Shuttle backwards and for-
wards commands to REWIND and 
Fast Forward
- FALSE
- TRUE

When TRUE automation in a strip is in 
independent by section. (fader, auxes 
EQ etc.) When False Entire strip 
changes status with fader
- TRUE
- FALSE
 Ramses Setup 2 - 18
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Page 13 Page 14 Page 15
Selects channel to Active Screen when 
Inject or fader is touched
- TRUE
- FALSE

Meter fall-back time for all Ramses 
Meters
in milli-seconds per step

Show/Hide plug-ins on Pyramix screen
(only Strip Tools at present)
- TRUE
- FALSE

Page 16 Page 17 Page 18
Buttons immediately above and below
EQ rotaries switch between Shelf and 
band-pass OR toggle selected band.
- TRUE
- FALSE

N/A at present Changes the ALL button behaviour 
from momentary to latch for the time 
set here per press.
Obviates necessity to hold down ALL 
button when applying e.g. Unity Gain
 Ramses Setup 2 - 19
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Page 19 Page 20 Page 21
Toggles between 18 independent 
AUXs or three banks of 6 (A, B, C)
- TRUE
- FALSE

Sets the length of time you have to 
hold a locator button (Lower Active 
Panel below Transport) to store the 
current value. In 100msec increments

In the inlikely event of a Ramses fail-
ure, create a log file
- TRUE
- FALSE

Page 22 Page 23 Page 24
Enable/Disable zoom into EQ, Dyn etc. 
pages when touched in Active Screen
- TRUE (disable)
- FALSE (enable)

Display Strip name on Alphanumeric 
display above the fader strip
- TRUE
- FALSE

Display current fader gain value in dB 
on Alphanumeric display
- none
- under name
- above name
 Ramses Setup 2 - 20
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Page 25 Page 26 Page 28
Display EQ curve and Dynamics action 
on Alphanumeric display
- TRUE
- FALSE

Strip Label position (If ON) on the 
Alphanumeric display
0 = top

Number of Strips per Bank in 4 Strip 
units
1 = 4 Strips per press of Bank R or L
2 = 8 Strips per press of Bank R or L
 Ramses Setup 2 - 21
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3 Fader Panel

Overview

Each Fader Panel consists of 8 identical Fader Strips with an alphanumeric display at the top. Depending 
on which model Ramses MSC you have, you will have one, two or three Fader Panels.

Fader Panel
 Fader Panel 3 - 22
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 Fader Strip
FADER DISPLAY

This usually shows you the channel 
number or name and can display 
other information depending on the 
console mode such as EQ curves etc.

SOLO TOUCHPOINT AND 
INDICATOR

Touch this to solo a channel. The indi-
cator will light to indicate the channel 
is in solo

CHANNEL TYPE INDICATORS
G is lit when channel is a Group VCA Master 
within Pyramix project. (To be implemented)
A is lit when channel is a Aux Bus Master.
M is lit when channel is a Mix Bus Master.
E will be lit for future purposes
When none is lit - channel is normal audio 
channel.

HOLD BUTTON
Press this button to lock this channel 
in its slot.
It will now stay in place regardless of 
Ergonomic Spread recall, undo, etc… 
functions

INJECT TOUCH POINT
Touch this point and then, whilst hold-
ing it, swap channels, aux, busses, 
paste EQ/dyn, track arm and many 
other functions.

ARMED TRACK INDICATOR

CHANNEL METER

MUTE BUTTON

CHANNEL NUMBER

AUTOMATION STATE INDICATORS

NULL INDICATORS

FADER
 Fader Panel 3 - 23



Ramses MSC reference guide
EQ Panel : Overview
4 EQ Panel

Overview

Each EQ Panel consists of 8 identical Strips. Depending on which model Ramses MSC you have, you will 
have one or two EQ Panels.

EQ Panel
 EQ Panel 4 - 24
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EQ Aux and Pan Strip

Each EQ Strip has a series of dedicated EQ controls.  There are three Dual-concen-
tric Encoders, the top of which control the gain and the bottom the frequency for 
each band.  The settings of each EQ band are displayed using the EQ Fans around 
each encoderFor access to EQ controls additional to those on the channel strip, 
such as Q, band in/out and Filter controls - use the Active Panel.EQ Strip Overview

1. shelf

2. HF band EQ  dual-concentric encoder and display

3. MF band EQ dual-concentric encoder and display

4. LF band Eq dual-concentric encoder and display

5. shelf 

6. Master eq

7. more indicator

8. aux select buttons

9. aux knob.

10.aux IP (In-Place) button

11.aux PF (Pre-Fade) button

12.aux on/off button

13. pan/balance knob

1

2

3

4

5

6

8

9

10 11

12

13

7

 EQ Panel 4 - 25



Ramses MSC reference guide
EQ Panel : EQ Aux and Pan Strip
1 shelf
The low pass shelf Button switches the top band of EQ to a shelving type filter. This also changes the EQ 
Fan display to Shelving mode.

2,3 and 4 HF, MF and LF eq eq display

The three fan displays are very similar. The differences are:

• The frequency legends are appropriate to the band. However, the frequency range is the same as 
the equaliser band being controlled. When the selected frequency cannot be displayed the out of 
range indicator will light.

• The mid band has two out of range indicators. the low and high bands logically only have one 
each.

• the ‘spare’ LED in the low and high bands is used to indicate HPF (High Pass Filter) and LPF (Low 
Pass Filter) active.

5 shelf
The high pass shelf Button switches the bottom band of EQ to a shelving type filter.  This also changes the 
EQ Fan display to Shelving mode.

6 Master eq
The Master eq Button toggles the entire EQ section in/out of the signal path.

7 More Indicator
The 'More' Indicator is lit whenever there is more EQ applied than is displayed by the channel strip EQ con-
trols - such as additional bands of EQ.

8 aux select
The aux Select section allows control over 12 discreet Aux Sends per channel (1 to 8 channels), and 6 
Sends for N-1 Mixes and/or Talkbacks You can also see the settings for all Aux's on the Active Screen. The 
sends are divided into into three banks (A,B,C) A & B are for standard Aux's and bank C is used for N-1 
(mix minus) Mixes and talkback (please refer to the Monitor section of the Pyramix User Manual)
 EQ Panel 4 - 26
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9 aux knob
Controls the send level to the selected aux bus.

10 aux IP
When lit Aux will be sourced from the ‘In Place’ strip output including fader gain.

11 aux PF
When lit Aux is sourced pre-fader

12 aux on/off
Toggles selected Aux send on and off. On when lit.

13 pan
The pan encoder on the channel strip allows pan / balance control from left to right in the pan field.  For sur-
round panning, use the Joystick on the Active Panel. Please see: .  Divergence and LFE controls can 
also be updated from the Active Panel.

The channel strip pan encoders display surround information as well as the left to right position.  There will 
always be a single LED to indicate the left to right position - this LED travels from 9 o'clock to 3 o'clock 
across the top of the encoder.  If there is any front to back panning information, the bottom 5 LED's below 
this line display the F-R position.

• If there is no front-to-back information, the bottom front-to-back LEDs will not be lit.

• If the pan position is all the way to the front, the bottom front-to-back LEDs will not be lit.

• If there is front-to-back information but the pan position is all the way to the left, only the left front-to-
back LED will be lit.

• If there is front-to-back information but the pan position is all the way to the right, only the right front-
to-back LED will be lit.

Note: For access to EQ controls additional to those on the channel strip, such as Q, band 
in/out and Filter controls - use the Active Panel.
 EQ Panel 4 - 27
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EQ Summary. 

EQ Fan Spoke Values 

EQ Fans
The number of LED's lit in  
each “spoke” represents the 
degree of cut or boost applied 
by this band of EQ.  When 
cutting, the spoke grows from 
the rim towards the centre of 
the EQ Fan, when boosting 
the spoke grows from the 
centre towards the rim.  The 
exact amount of cut or boost 
is displayed on the Active 
Screen (see chart below).

Shelf
The low pass Shelving Button switches the 
top band of EQ to a shelving type filter.  This 
also changes the EQ Fan display to Shelving 
mode.

Shelf
The high pass Shelving Button switches the 
bottom band of EQ to a shelving type filter.  
This also changes the EQ Fan display to 
Shelving mode.

Master EQ
The Master EQ Button toggles the entire EQ 
section in/out of the signal path.

LPF Indicator
The LPF Indicator is lit whenever the LPF Fil-
ter is engaged - This parameter is controlled 
through the Active Panel (see below).

Out of Range
The Out Of Range Indicators are lit when the 
frequency selected is outside the EQ Fan's 
display range.

Rim Light
A Rim Light is lit whenever 
this band of EQ is engaged. 
green indicates no cut/boost, 
red indicates cut and yellow 
indicates boost.  Each spoke 
is lit whenever the selected 
frequency is the same as or 
higher than the frequency 
marked next to the spoke.

More Indicator
The 'More' Indicator is lit 
whenever there is more EQ 
applied than is displayed by 
the channel strip EQ controls 
- such as additional bands of 
EQ.

HPF Indicator
The HPF Indicator is lit whenever the HPF Fil-
ter is engaged - This parameter is controlled 
through the Active Panel (see below).

EQ Fan Spoke Display 
 

No Spoke LEDs illuminated       =  No Cut or Boost Applied  
1 Spoke LEDs illuminated     = up to 1.99 dB Cut or Boost  
2 Spoke LEDs illuminated     = 2 to 3.99 dB Cut or Boost  
3 Spoke LEDs illuminated     = 4 to 5.99 dB Cut or Boost  
4 Spoke LEDs illuminated     = 6 to 9.99 dB Cut or Boost  
5 Spoke LEDs illuminated     = 10 to 14.99 dB Cut or Boost  
6 Spoke LEDs illuminated     = more than 15 dB Cut or Boost 
 EQ Panel 4 - 28
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5 Monitor Panel
Note: If you are unfamiliar with the Pyramix Monitor Section Please see: .

Monitor Panel Overview
                                                          Page No.

1. Bus Peak Meters
2. External Source select buttons
3. Mix Source select buttons
4. Monitor Mute buttons
5. surround speaker select
6. stereo speaker select
7. near speaker select
8. down-mix (toggle)
9. dim encoder and switch (press)
10. Dim indicator
11. Master Control Room Volume
12. inplace (solo)
13. ref level (monitors)
14. slate - Talkback - Slate button
15. talk 2 - Talkback 2 button
16. talk 1 - Talkback 1 button
17. TimeCode display
18. Display Offset button
19. Mark TimeCode location button
20. store TimeCode location button
21. cycle Mode button
22. recall TimeCode location button
23. loc 'Locate to' button / Scene loc
24. Numeric Keypad (not Pyramix)
25. clear TimeCode display button
26. << - Rewind button
27. >> - Fast Forward button
28. stop button
29. play button
30. record button

Monitor Panel

28 29 302726

25 23

22

21

20

19

18

24

17
9

11
16

15

14

10

8

7

6

5

4
2 3

12

13

1
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1 Bus Peak Meters 1 - 6
The Bus Peak Meters display the levels of the Bus that is currently selected using the Monitor Mix Sources 
(see page) or External Sources (see page ) buttons.

The bus elements are displayed, left to right, in the following order: Left, Centre, Right, Left Surround, Right 
Surround, Sub (or LFE).

Thus, if Mix Source A is selected, the Meters display the signals present on Mix Bus 1 as shown in Pyra-
mix monitoring from top to bottom.  If External Source button 4 has been pressed, the Meters display the 
signals present on External Source 4.

Note: since the Mix Source buttons are 'radio' buttons in a group with the External 
Source buttons and exclusive, i.e. only one selection at a time is permitted, these Meters 
will always be monitoring either a External Source or Mix Source signal.

Note: Since there are 6 Peak meters, when a stereo signal is selected, only the Left and 
Right Peak Meters will be active.

2 External Sources 1 to 5 and “+”
External Sources 1 - 5 switch the monitors to monitor incoming signals from External Sources . The last 
button "+" cycles through all the available External Sources as defined and shown in the Pyramix Monitor.

The number of External Sources available for selection is defined by the number of External Sources Pyra-
mix has been set up to monitor - if there are only three External Sources defined in the Pyramix Monitor, 
buttons 4 and 5 will do nothing.

These are mutually exclusive 'radio' buttons in a group with the Mix Source buttons (A - E and +), so either 
an External Source button or a Mix Source button must always be selected.

Meter Bridge
The Mix Source or External Source selected in the Monitor section is highlighted in the Meter bridge, 
please refer to Meter Bridge section for details.

Tips and tricks
External Sources can be used for other purposes than the traditional "tape returns". Every source required 
in your setup can be seen as an external source since the External Source buttons can also be used as as 
a routing tool: Hold the desired External Source button and press Inject on the desired Ramses Slot. All 
the connected Inputs of the External Source will then be controlled and routed by the Ramses Slot con-
trol Strip. E.g. if External Source 1 has 4 mono inputs and you Inject it into Slot 5 and all Slots are stereo, 
than Source 1 will be connected as follows: Slot 5 input External Source 1 Channels 1 and 2 / Slot 6 Exter-
nal Source 1 channels 3 and 4.

Summing
To sum Mix Sources and External Sources select the first source by pressing its button then add sources 
by holding down the Mod button and adding more sources by pressing their buttons.

3 Mix Sources A to E and toggle "+"
Mix Sources A - E switch the monitors to monitor incoming signals from External Sources . The last button 
"+" cycles through all the available External Sources as defined and shown in the Pyramix Monitor.

The Mix Source buttons switch the monitors to monitor signals on Mix Busses A to E. The last button "+" 
toggles - cycles through all the available Mix Sources as defined and shown in the Pyramix Monitor 
 Monitor Panel 5 - 30
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The number of Mix Source buttons available for selection is defined by the number of Mix Busses config-
ured in Pyramix. If there are only three Mix Busses configured in the Pyramix, buttons D and E will do noth-
ing.

These are mutually exclusive 'radio' buttons in a group with the External Source buttons (1 - 5 and +), so 
either an External Source button or a Mix Source button must always be selected.

Tips and tricks
Especially for Multistem mixing, you can “unfold”  Mix Buses (click "+" on the Mix Bus in the Pyramix Mon-
itor Section), then you can cycle through all the Stems from the Ramses Mix Sources A-E and "+" buttons. 

Note: This option will be added in future release under the Monitor section in the Active 
Screen.

Summing
To sum Mix Sources and External Sources select the first source by pressing its button then add sources 
by holding down the Mod button and adding more sources by pressing their buttons.

4 Monitor Mute / SOLO buttons L, C, R, LS, RS, SUB

Mute
The Monitor Mute buttons Mute the Monitor Source channels routed to the corresponding speaker loca-
tions.

Thus if C is pressed, the 'C' or Centre signal of the bus(es) currently selected to the Monitors is muted and 
the indicator lit.  

Note: This is purely a monitoring function. It does not affect the signal present on the bus 
itself, which will continue sending as per normal.

Solo
When used with the Mod button, the The Monitor Mute buttons Solo the Monitor Source channels routed 
to the corresponding speaker locations.

Thus if C is pressed, the 'C' or Centre signal of the bus(es) currently selected to the Monitors is Soloed and 
the indicator lit. All other source channels are muted.

The solo mode follows the currrently selected solo mode in the Pyramix monitor.

5, 6, 7, and 8 Speaker Sets and Downmix

surround
Selects the Surround Speaker Set currently set up in the Pyramix Monitor.

stereo
Selects the Stereo Speaker Set currently set up in the Pyramix Monitor.

near
Selects the Near-field Speaker Set currently set up in the Pyramix monitor.
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down-mix
Selects the Down Mix currently set up in the Pyramix Monitor (toggle)

Note: Only one Speaker Set can be selected at a time. The down-mix button toggles forc-
ing the down mix currently selected in the Pyramix Monitor onto the current Speaker Set.

Tips and tricks
The three speaker sets available on the Ramses surface take the first three Speaker Sets (top down) that 
appear in the Pyramix Monitor. Copy/Paste is available in the Pyramix Monitoring section to help reorder 
the Speaker Sets.

9 and 10 Dim Encoder / Button (press) and Indicator
This control is both a Button and an Encoder.  Pressing down on the dim knob engages the Dim Mode.  
When Dim Mode is engaged the volume of the currently selected Speaker Set is reduced to the Dim Level 
and the Dim Indicator is lit.  The Dim Level is determined by the Pyramix Monitoring, please refer to "how 
to" section (page ?).

Pressing the Dim knob toggles Dim Mode on/off.  When Dim is engaged, the speaker volume can be 
adjusted with the Dim Knob. Pressing the Dim Knob again will restores the output volume to the original 
level determined by the main Monitor Volume encoder.

11 Main Monitor Volume Encoder
The Volume Knob adjusts the volume of the Monitor Bus(es) that is/are currently feeding the control room 
speakers. This control is always active unless Dim Mode or Ref Mode is engaged.

12 inplace

13 ref
The reference button sets the level of the monitor outputs feeding the Control Room speakers to a pre-
determined level, bypassing the Volume knob. The ref level is set and stored in the Pyramix Monitor sec-
tion, please refer to "how to" section (page ?). There is one ref level for all three speaker set.

Normal Operation
When the ref button is pressed the Main Monitor Volume Encoder setting is bypassed and the level of the 
selected monitor Bus or buses is set to the Reference Level for the currently selected Speaker Set.  Press-
ing the ref button again exits this mode and re-activates the Volume Control.

Reference Button Indicator
The Reference Button Indicator is lit whenever the ref button is held down, or the Ref Mode is active.
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14, 15 and 16 RAMSES CONSOLE TALKBACK FUNCTIONS

14 Slate button

15 Talk 2

16 Talk 1

Overview
The Ramses Console's Talkback buttons use the Talkback functions in the Pyramix Monitoring section. 
please refer to the "how to" section (page ?). The Talkback can be sent to any Mix Bus or Aux (one at the 
time). There is one Dynamic Microphone integrated in the Ramses Console, the signal can be recuperated 
at the XLR on the back of Ramses and fed into a Pyramix strip (or any other microphone fed to a Pyramix 
strip). The Pyramix strip will have to be properly routed so that the microphone signal only feeds the 
desired busses - auxes. Adjustment of the Talkback gain is also available in Pyramix Monitor section. 

How to use the Talkback Functions:
Providing the above steps of defining a Talkback channel and destinations for each destination Buttons 
have been completed, pressing the Talk 1 or 2 will now engage the Talkback function.

Talk Buttons
The Talk Buttons have both a momentary and latching action.  When pressed and held, they will engage 
talkback for as long as the button is held down.  When pressed briefly (less than 1 second) they will latch 
the Talkback function ON until it is pressed again, or held and released.

Depending on the settings made in the Pyramix Monitor Talkback page, initiating talkback can also apply 
the Monitor DIM function (which can be dynamically adjusted using the DIM Encoder) to avoid howl round 
when talking to a studio with an open mic.

Slate Button
The Slate button will send Talkback to a Bus (Selected in the Pyramix Monitor Talkback page) while dim-
ming the main monitors.

17 TimeCode Display
Overview
This display is the main TimeCode display for the Ramses MSC. There are two modes: Active or Data 
Entry.  

When Active, it displays the current TimeCode position of the playhead cursor.  This updates in real-time.

The TimeCode value displayed can be the identical to the current Pyramix TimeCode position, or it can 
include a display offset entered by using the Display Offset button (see page 16).  

In Active Mode, pressing any 0-9 Keypad button (see page ?) enters Data Entry Mode, clears the display 
and enters the digit just pressed into right-most position of the display.

Pressing the Clear button (see page ?) at any time enters Data Entry Mode (if not already active) and sets 
the display to 00.00.00.00.

Pressing the Clear button twice quickly at any time reverts the display to Active Mode.
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Normal Operation
When in Data Entry Mode the display is static and numbers can be entered using the Keypad. The number 
entered can then be used for further locate functions as described below. From Data Entry Mode - the dis-
play returns to Active Mode after performing a locate command (such as Store (see page ?), Locate (see 
page 17), Play, or Stop) or hitting Clear twice in quick succession. 

When in Data Entry Mode, every second decimal point in the display is lit to distinguish this from Active 
mode.

18 Display Offset button
*** Reserved for future software releases ***

19 Mark button
Overview
The Mark button allows the capture of the current TimeCode position. This can be achieved whilst Pyramix 
is in any transport mode.

Normal Operation
When pressed, the TimeCode display changes from Active to Data Entry mode (if not already active) and 
will display the TimeCode value where the play-head cursor was positioned when the button was pressed.  
The displayed number can now be stored into Keypad buttons 0-9 using the Store button (see below).  You 
can locate to this position by hitting the Loc button without needing to store the number.

The TimeCode display will remain in Data Entry Mode until the Transport state changes (e.g: Play is 
pressed).

Pressing the Clear button twice also returns the display to Active Mode.

20 Store button
Overview
The Store button enables the currently displayed TimeCode location to be stored into Locator buttons 
(numeric keypad) 0-9 or the Smart Locate buttons 1-4 on the Lower Active Panel.

Normal Operation
With the desired TimeCode displayed in Data Entry Mode press Store.  The Store indicator now flashes, 
and all locator buttons (of Keypad buttons 0-9 and Ramses Locate buttons 1-4) that already contain previ-
ously stored times are lit.  

Now press a Keypad button 0-9 or a Smart Locate button 1-4 to store the displayed value into that button.  
The TimeCode display now returns to Active Mode.

Pressing Store whilst in Play with the TimeCode display in Active Mode is equivalent to pressing both Mark 
and Store.

To exit Store mode without storing a number either hit Store again or touch either of the Solo Clear touch 
points (see page ?).

21 Cycle button
The Cycle button toggles Cycle mode on/off in Pyramix. It cycles between the red (Mark In) and the green 
(Mark Out) on the Pyramix timeline. 
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Note: In a future software version it will be possible to set these markers in the Active 
Screen Machine page.

22 Recall button
Overview
The Recall button retrieves a TimeCode location stored either in a Keypad button or a Ramses Locator 
button and enters this number into the TimeCode display.  This number can now be manipulated in any way 
using the locator functions.  You can locarte to it using the Locate button or store it in another button etc...

Normal Operation
To recall a stored TimeCode value, press the Recall button. The Recall button indicator now flashes and 
indicators in buttons with stored locations (including the Fast Locate buttons 1-4 on the Lower Active 
Panel - see page are lit. Now pressing any 0-9 button or Lower Active Panel 1-4 button will switch the 
TimeCode display to Data Entry Mode (if not already active) and load the number stored in that button into 
the TimeCode display. 

If a button is pressed that has no stored TimeCode value nothing happens.  Once a number has been 
recalled the Recall button indicator is extinguished and the keypad 0-9 button or Lower Active Panel 1-4 
button pressed is lit to indicate which Locate is currently displayed.

Note: Recall does not affect the transport controls in any way. The Timecode display 
reverts to Active Mode when the Transport changes state (eg: hit Play or Stop. At this 
point all Keypad button indicators and Smart Locate indicators are extinguished except the 
last one used to Locate.

23 Locate button / Scene loc
Overview
In Data Entry Mode, pressing the Locate/Scene loc button moves the Playhead Cursor to whatever num-
ber is currently displayed by the TimeCode display.  This number could have been entered manually, been 
captured using the Mark button, or have been recalled using the Recall function. 

Normal Operation
If pressed while in Play the Transport state will be maintained throughout this operation, so if in Play before 
pressing loc, Pyramix will move the Playhead Cursor to the new location and then continue to Play.If the 
Loc button is pressed whilst in FF or RW or stop Pyramix locates to the new TimeCode position and then 
remains in Stop.

Pressing the loc button in Play whilst the TimeCode display is in Active Mode does nothing - this button is 
only relevant if in Data Entry Mode. The Timecode display returns to Active Mode after hitting the loc but-
ton. 

loc button indicator
The loc button indicator is lit when the button is pressed.

Note: Transport locators will be saved and re-opened as in Ramses template.

24 Numeric Keypad (not Pyramix)
Overview
The Keypad buttons are used to enter TimeCode locations into the TimeCode Display when in Data Entry 
mode.  They are also used as locations to store TimeCode values in Store and Recall modes.
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Normal Operation
Whilst the Timecode display is in Active Mode, pressing any keypad button 0-9 changes the timecode dis-
play to Data Entry Mode, clears the display and enters the number just pressed into the right most location 
of the display. Pressing further numbers will now enter  the number pressed and scroll the existing numbers 
progressively to the left.

Data Entry Mode is indicated by every second dot on the Timecode display being illuminated.

Once a number has been entered further locate functions can be applied such as Locate or Store.

To clear the TimeCode display to 00.00.00.00 hit Clear at any time.

To return to Active Mode hit Clear twice.

Keypad buttons 0-9 as storage locations for TimeCode values
The keypad numbers can also be used as storage locations for TimeCode values.  See the Store (page 16) 
and Recall (page 16) buttons for more detail on these modes.

25 Clear button
The clear button sets the TimeCode display to Data Entry Mode (if not already active) and sets the Time-
Code Display to 00.00.00.00.

At this point a numerical TimeCode position can be entered using the Keypad buttons 0-9. 

Pressing clear twice quickly, returns the TimeCode display to Active Mode.

26, 27, 28, 29 and 30 Transport Controls
Rewind button
The Rewind button sends a Rewind command to the Pyramix Active Machine.  

Rewind button indicator
The Rewind button indicator is illuminated whenever the system is in Rewind.

Fast Forward button
The Fast Forward button sends a Fast Forward command to the Pyramix Active Machine.  

Fast Forward button indicator
The Fast Forward button indicator is illuminated whenever the system is in Fast Forward.

Stop button
The Stop button sends a Stop command to the Pyramix Active Machine.  

Stop button indicator
The Stop button indicator is illuminated whenever the system is in Stop.

Play button
The Play button sends a Play command to the Pyramix Active Machine.  

Play button indicator
The Play button indicator is illuminated whenever the system is in Play.
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Record button
The Record button sends a Record command to the Pyramix Active Machine.  

Record button indicator
The Record indicator is illuminated whenever the system is in Record.

Tips and Tricks
The Record button will be inactive if no Tracks are record enabled. The Record button will also be inactive 
if no Target Media Drives have been set for the current Pyramix Project. A popup window will show up in 
Pyramix indicating either of these conditions. So long as this popup remains open you may not be able to 
operate Ramses normally. 

Monitor Setup in Pyramix

The Pyramix Monitor (Version 6 or higher with MassCore option) setup is system based (as opposed to 
stored with individual Projects). A monitor setup is saved when the Pyramix application is closed. All the 
Projects you open with your Ramses MSC will have the Monitor section currently stored in Pyramix.

However, Talkback assignments and Mix Buses are saved with Pyramix Projects.

Before you can use the Monitor it must be enabled by clicking the button in the top-left corner of the window 
so that it lights yellow.

By default the Monitor window is hidden. It can be opened with View > Monitor or the  icon in the 
View Toolbar. 

Note:   Please see: Pyramix Monitor Section  on page 62 for full details.

Tips and tricks 
Ramses makes available the speakers sets (orange buttons) set up in the Pyramix monitor section. They 
are mapped in top to bottom order from the list in Available Sets.

Monitor Main Monitor !  Window
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Since the Ramses buttons are labeled surround, stereo & near you may wish to follow this convention 
when naming speaker sets in the Pyramix Monitor.

External Sources in Pyramix
Note: Pyramix External Monitor Sources e.g. recorders, are set up in the Pyramix Monitor

Talkback in Pyramix
Note: Pyramix Talkback which provides the Ramses talkback functionality is set up in the 
Pyramix Monitor

Meter Bridge Setup in Pyramix

The Meter Bridge is Project based in Pyramix 6. (This might change in 6.1). So please bear in mind that it 
must be enabled in each project. (Pyramix Mixer Configure page, bottom-left)

Although you can set it up in the space you need or want it has been designed to fit 32 strips per row across 
a 19” TFT screen. 

Tip
If you enable the Meter Bridge in your Templates then it will be enabled by default in your Projects.

Note:   Please see: Meter Bridge  on page 80 for full details.
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6 Expert Panel

Expert panel Overview
1. mod button (modifier)

2. (all) button
3. pfl/afl - Solo Mode toggle PFL/AFL button
4. sip - Solo Mode - Solo In Place button
5. solo clear touch point

Ergonomic Spread Buttons
6. chair (ARC ONLY) 
7. undo 
8. redo 
9. touch
10. store
11. recall
12. erg1 - erg8 Hotkeys 1-4 and 5-8 with mod

Grouping
13. +  Add to Group button
14. group mode button
15. - Subtract from Group button
16. faders Target Indicator

mutes Target Indicator
others Target Indicator

Automation
17. release Time Knob
18. snap button - Release Mode
19. Auto release - Release Mode
20. to next - Release Mode
21. to end - Release Mode
22. trim Mode button
23. hold - Release Mode
24. snapshot - (Write Keyframe)
25. snaprange (Write Range Keyframe
26. mute button (ARC only)
27. unity button
28. arm Track button
29. m1 & m2 Memory 1&2 (Clipboard) buttons
30. isolate Mode button - Automation
31. read Mode button - Automation
32. write Mode button - Automation

Navigation
33. < channel Nudge 1 Channel to the Left
34. > channel Nudge 1 Channel to the Right
35. << bank Nudge 1 Bank to the left
36. >> bank Nudge 1 Bank to the Right
37. A - aux Show Aux Master buses
38. M - mix Show Mix master Buses
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Expert Panel Overview

This panel includes controls used to manipulate your work environment.

It includes the following blocks of controls:

Navigation Block : Controls navigation through channels and buses
Solo Block : Controls the behaviour of the Solo functions
Ergonomic Spread Block : Controls the selection of Channels into Slots
Grouping Block : Controls Grouping Functions
Automation Mode Block : Controls Automation modes 
Strip Modifier / Automation Block : Allows different modes of interaction 

1 Modifier button - mod
Overview
The mod button acts like a Shift key in that it changes the function of other controls on the surface.  It is 
mainly used for the following purposes (while holding mod):

• with the top encoder of an EQ changes the Q factor

• Enables ergonomic spreads 5 - 8 to be recalled or stored 

• with isolate, read & write changes the global automation mode

• Enables mix buses to be summed in the monitoring section

mod button indicator
This indicator is illuminated whenever the Smart button is pressed.

2 All button
The all buttons, when pressed, are the equivalent of selecting all channels/strips of your mixer. To apply a 
change everywhere, it can be seen as a modifier.

Both all buttons operate identically.

For example:
Holding down the unity button and then pressing an all button will set all faders available in the current 
project to Unity (0dB). This is not yet implemented with plugins, auxs or pans.

ALL button indicator
The all button indicator is illuminated whenever either all button is pressed.

Tips and Tricks
In the Ramses System > Configuration pages a timed value can be set which determines the length of 
time that the ALL  remains active after it has been pressed. This avoids the need for multi-fingered virtuos-
ity in order to access multi-button functions.

3 pfl/afl button
Overview
The pfl / afl button toggles the solo mode between Pre-Fade-Listen and After Fade Listen i.e. normal Solo.
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PFL/AFL button indicator
The pfl / afl button indicator is lit whenever the console is in Pfl or Afl Solo Mode

4 SIP button
Overview
The SIP button toggles the solo function between Solo-In-Place and normal.

SIP button indicator
The SIP button indicator is lit whenever the console is in SIP solo mode.

5 Solo Clear touch point
Overview
Touching the Solo Clear touch point (which is also the Solo Master indicator) clears any and all currently 
active solos.  It is functionally identical to the Solo Clear touch point on the Lower Active Panel (SEE 
PAGE)

Normal Operation
If any channel is solo-ed the Solo Master indicator will be lit. Now, when touched, all solos will be removed, 
all channel Solo indicators extinguished, the Solo Master indicator itself will be extinguished and the moni-
tors resume their normal monitoring mode.

Additional Functions
The Solo Clear touch point also acts as an escape style command for various different modes.  When 
touched while in Grouping Mode, it exits Grouping Mode and reverts to the group states before Group 
Mode was entered. Similarly in Ergonomic Spreads Store Mode, when pressed the Store mode is 
cleared.

Solo Master indicator
The Solo Master indicator is illuminated if any channel is solo-ed.

Note: This control has two functions.  It's indicator functions as a Solo Master indicator, 
while it's Touch Control functions as a Solo Clear.

Tips and Tricks
The Solo Clear touch point also acts as an 'escape' style command for various different modes.  When 
touched while in Grouping Mode, it exits Grouping Mode and reverts to the group states before Group 
Mode was entered. Similarly in Ergonomic Spreads Store Mode, when pressed the Store mode is cleared.

6 Chair button - ONLY AVAILABLE WITH ARC OPTION
Overview
The Chair button toggles between Chair Mode and Wipe Mode.  These two modes determine how chan-
nels are selected using when touching Segments on the ARC™.  These modes apply equally to any type 
of signal paths the ARC™ is displaying using the Aux "A" or Mix "M" Buttons.

Chair Mode
In Chair mode, when you touch a Segment of the ARC™, your finger becomes a central point, represent-
ing your chair, and the strip you are pointing to as well as those surrounding your finger are immediately 
loaded into all available strip Slots.  The number of channels or segments being loaded into Channel Slots 
is displayed by a 'window' of lit channel numbers on the ARC™.
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The size of the 'window' of faders selected around your finger, is determined by the number of physical 
strips, or Slots, your console has, minus the number of strips currently in Hold (see page) Thus a 16 fader 
console with 6 faders in hold, will display a 'window' 10 segments wide.

A slot with its Hold button on will not have its channel updated by this process.

A Slot whose fader is currently being touched will have a channel assigned to it as if it were a normal 'un-
held' channel, but this slot will not be re-assigned until it's fader is released. 

When the 'window' consists of an even number of ARC™ Segments, the centre point of the window around 
your finger will be the left member of the middle pair of Segments.  For example, if the window is 10 Seg-
ments wide, there will be the four strips to the left of your finger, and five to the right, with the fifth window 
being the one your finger is on.

A further example:
In a 16 fader console, with slots 4,7,9 and 13 held (with their corresponding channel numbers) touching the 
ARC™ in chair mode at Segment 35 would result in a window 12 Segments wide and will load channels 
into slots resulting in the following order of channels: 30,31,32,4,33,34,7,35,9,36,37,38,13,39,40,41.

Note: When you touch segments near either end of the ARC™ the 'window' does not slide 
off the end but rather remains at full width and ceases moving.

Wipe Mode
Wipe mode allows the selection of non-sequential arrangements of channels.  Here, touching the ARC 
Segments (in any order) on the ARC Selector Strip fills in individual channels sequentially from the left most 
available physical channel through to the right most.  The process starts again, and the left most available 
physical channel slot is again filled, when the Timmometer decays.  

Chair button indicator
The Chair button indicator is lit when the console is in Chair mode.  When the console is in Wipe mode, 
the indicator is extinguished.

Please note that this button is inactive without the ARC option 

7 Undo button
Pressing the Undo button reverts to the previous ergonomic spread (layout).

Undo button indicator
The Undo button indicator is lit whenever there is a possible state to apply Undo to.

8 Redo button
Pressing the Redo button re-asserts the ergonomic spread (layout) in use prior to hitting Undo.

Redo button indicator
The Redo button indicator is lit only whenever there is a Redo action available.

9 Touch button
Some physical controls on the Ramses Console are not touch-sensitive.  The touch button allows you to 
use these controls in touch automation modes as if they were touch-sensitive.

If, under touch automation mode, a non touch-sensitive parameter is altered, it will send a touch message 
to the engine, triggering the engines usual response to a control that has been 'touched'.  Now the Touch 
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button will light and the parameter you just updated will remain in touch mode until you press the touch but-
ton.  At this point the Touch button is no longer illuminated and the parameter you moved no longer sends 
'touched' messages.   You can move as many parameters as you like and the touch button will continue to 
send touch messages for all those parameters until it is pressed at which time touch is released for those 
controls.

Arming non touch-sensitive controls
Should you want to put a non touch parameter into 'touch' without moving the parameter, press and hold 
the touch button and then move a non-touch control on the surface.  This will end a touch message to the 
engine - but while, the button is held down, the controls themselves are prevented from changing their val-
ues.  This is similar to the way in which parameters are selected for copying via the m 1-2 buttons (see 
page).

Note: It is possible to touch parameters by holding down the touch button and then wig-
gling the control even if some controls are already in touch mode and the button is lit.  
When releasing the button after such an action, the button remains lit and parameters 
already in touch remain so.  In this case, to release touch from all parameters, press the 
Touch button.

The Faders, aux knobs and joystick are true touch-sensitive controls and send touch messages when they 
are indeed touched.

10 Store button
Overview
An Ergonomic Spread is the layout of faders currently selected to the surface of the console.  The Ergo-
nomic Spread Store button allows the storage of the current Ergonomic Spread into one of the Ergo-
nomic Spread buttons 1-8.

Note: Storing and Recalling an Ergonomic Spread is an entirely non-destructive process.  
The only thing that updating, recalling or modifying an Ergonomic Spread affects is which 
faders are currently selected to the slots in your console.

Normal Operation
Pressing the Store button lights the Store button indicator and enters Store Mode - until one of the four 
Ergonomic Spread buttons on the Expert Panel is pressed, or using the mod button to access Ergo-
nomic Spread 5-8 - at which point the current Ergonomic Spread is stored into button and Store Mode is 
exited.  

To escape from Store mode without storing the spread - touch either Solo Clear touch point.  This will 
extinguishe the Store button indicator and exits the mode.

A Store operation will store the state of slots, including HELD Channels.  HELD channels are, however not 
updated by the corresponding RECALL command - see below.

Store button indicator
The Ergonomic Spread Store button indicator is lit whenever the system is in Ergonomic Spread Store 
mode.

Tips and tricks

The Ergonomic Spread is stored in Templates and is part of their recall (see page)
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11 Recall button
Overview
An Ergonomic Spread is the layout of faders currently selected to the surface of the console. The Ergo-
nomic Spread Recall button allows the recall of an Ergonomic Spread from one of the Ergonomic 
Spread buttons 1-4 or with the mod button Ergonomic Spreads 5-8

Note: Storing and Recalling an Ergonomic Spread is an entirely non-destructive process.  
The only thing that updating, recalling or modifying an Ergonomic Spread affects is which-
faders are currently selected to the slots in your console.

Normal Operation
Pressing the Recall button starts the Recall button indicator flashing and lights the Ergonomic Spread 
buttons 1-4 that contain a saved Ergonomic Spread. Pressing the mod button will do the same for Ergo-
nomic spread 5-8.

This state remains active until an Ergonomic Spread 1-4 button (or 5-8 with mod button) is pressed that 
contains a stored Ergonomic Spread - at which point the Ergonomic Spread stored in that Segment or 
button is recalled and applied to the console.  Now both the Recall button indicator and UPO indicators are 
extinguished and Recall Mode is exited.  Held Channels are not updated by this process and retain their 
original channels.

Note: Whilst in Recall mode an Ergonomic Spread 1-4 button that does NOT contain an 
Ergonomic Spread - does nothing. Recall Mode remains active.

Escape from Recall mode
At any time you can escape from Recall mode without having selected any new Ergonomic Spread by 
touching either of the Solo Clear touch points.

Recall button indicator
The Ergonomic Spread Store button indicator will be lit whenever the system is in Ergonomic Spread 
Recall mode.

Tips and tricks
• It is not necessary to press recall each time, just touching the desired Ergonomic Spread number 

is sufficient to recall it.

Note: The button will only light if there is a previously stored Ergonomic Spread.

12 Ergonomic Spread buttons 1 - 4 / 5 - 8
The Ergonomic Spread buttons 1-4/5-8 are storage locations for Ergonomic Spreads.  

Ergonomic Spread buttons 1-4 indicators
An Ergonomic Spread button indicator is lit when it has an Ergonomic Spread Stored.  These stored 
Ergonomic Spreads are saved with each console Template or in the Pyramix project (see page) 

13 Add to Group button (+)
In Grouping Mode
When in Grouping mode, pressing the + button initiates 'add to existing group' mode.  See the Group 
button (page) for more details.

Expert Grouping Mode
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In Grouping mode, the + button, when pressed together with the - button, initiates Expert Grouping Mode.  
In this case both + and - indicators are lit and addition as well as subtraction from the currently selected 
group is possible.  See the Expert Grouping Mode description in the Grouping button page for more 
details.

+ button indicator
The + button indicator is lit under two conditions:

• Whenever the console is in 'Add to Group' Mode.  This is initiated by hitting the + button after hit-
ting the Group button.

• Whenever the console is in Expert Grouping Mode.  This is initiated by holding down both the - 
button and + button at the same time whilst in Grouping mode.

See the Group button description below for more details on these modes.   

14 Group button
Overview
Pressing the Group button opens and closes the grouping process.  Its indicator is lit whilst the mode is 
active. 

Note: As of today, you can group faders, mutes, solos and EQ. In a future version you 
will be able to group pans, Dynamics and all other plugins. Note that only faders are 
"linked" today and all other multi-value parameters have no offset in their grouping, so it 
will behave as a "hard link" This will be change in future release.

Fader Grouping
Adding Faders to or creating a new Fader group

• Press the Group button. (Group button indicator lights, the target indicator corresponding to the 
last selected target lights - Faders, Mutes or Others)

• Now touch any Fader.  (If not already, Faders are now selected as the grouping target and the Fad-
ers indicator is lit in the Meter Bridge).

If the first Fader touched is not already in a group, a new group is created consisting of (initially) just this 
Fader  and Group + Mode is automatically initiated (+ indicator is Lit). Now any Fader or Segment touched 
will be added to the group.  The group members are updated in real time to indicate all members of the cur-
rent group.

Note: Once you've created a new group and are adding Faders, touching a Fader that 
belongs to another group will remove the Fader from its previous group and add it to the 
group currently being modified.

If the first Fader touched is already part of an existing group - that group is now selected.  All Meter Bridge 
indicators for this group remain on. No Group modification is allowed now until either the Group or Group 
+ button is pressed. Any other group can be selected by touching one of it's members. Meter Bridge indica-
tors update to show this group's members.

Removing Faders from a Fader Group
• Pressing the Group - button whilst in Group mode will maintain the selection of the current Group, 

change from the + to the - indicator being illuminated and now allow the subtraction of any Fader/
segment touched from the currently selected Group.

Escape from the Group
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• Whilst in any Grouping mode pressing the Group button exits the Grouping mode

• Touching either Solo Clear touch point (Please see: 5 Solo Clear touch point  on page 41) 
escapes from Grouping mode and discards any changes made since the mode was initiated.               

Mute Grouping
Adding Mutes to or creating a new Mute group

• Press the Group button. (Group button indicator lights on Meter Bridge, the target indicator corre-
sponding to the last selected target lights (Faders, Mutes or Others)

• Now touch any Mute

If the first Mute touched is not already in a Group, a new Group is created consisting of (initially) just this 
Mute (only this Mute's Meter bridge indicator is now lit) and Group + Mode is automatically initiated (+ indi-
cator is Lit). Now any Mute or Segment touched will be added to the Group.  Meter Bridge indicators are 
updated in real time to indicate all members of the current Group.

Note: Once you've created a new group and are adding Mutes, touching a Mute that 
belongs to another Group will remove the Mute from its previous Group and add it to the 
Group currently being modified.

If the first Mute touched is already part of an existing Group - that Group is now selected.  No Group mod-
ification is allowed now until either the Group - or Group + button is pressed. Any other Group can be 
selected by touching one of it's members - Meter Bridge indicators update to show this Group's members.

Removing Mutes from a Mute Group
Pressing the Group - button whilst in Group mode will maintain the selection of the current Group, change 
from the + to the - indicator being lit and now allow the subtraction of any Mute/Segment touched from the 
currently selected Group. If no Group is selected on entering Group Minus Mode, the first Mute touched 
selects the Group to be subtracted from.

Escape from the Group mode
Pressing the Group button at any time exits the Grouping mode.

Touching the Solo Clear touch point escapes from Grouping mode and discards any changes made since 
the mode was initiated.

Additional Notes
It is possible to specify multiple Groups without ever leaving Group mode.  For example:

• Press Group (Group buttons indicator is lit).

• Any Faders now touched will become grouped together

• Press any Mute button and the grouping function now changes to Mute groups (Previous Group’s 
Meter bridge indicator's are extinguished and are replaced with Meter Bridge indicators for the new 
Groups mutes).

• Press any mutes desired to create new mute Group.

• Touch a Fader now and the grouping function switches back to Fader grouping (Previous Group’s 
Meter bridge indicators are extinguished and are replaced with Meter Bridge indicator for the new 
Groups Faders).

Note: It is possible to define multiple Fader groups in this way by pressing any mute but-
ton between Groups of Faders.  Pressing a single mute button and then another Fader will 
not create any Group for the mute.
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Temporary Adjustment mode
Faders

In order to perform Fader (or other controls that have been grouped) moves without invoking group 
laws, simply press and hold the - button down (indicator illuminates under your finger), wiggle a 
Fader, release Fader, then release the - button.  When the - button is released, the Fader returns to 
position previously held in relation to the group and normal grouping laws are re-asserted.  This 
allows quick adjustments of Faders independent of the group relationship.

Mutes

Mutes behave similarly in this mode with the exception of their behaviour after the - button is 
released. Pressing and holding down the - button and hitting a mute will toggle that channel's mute 
state independently of the mute group.  Releasing the - button does not revoke the mutes modified 
whilst in the temporary 'escape from group' mode but leaves them in the state they were changed 
to.  

Normal Group behaviour is asserted on the next Group change using the principle of positive assertion: If 
the first mute pressed after leaving temp adjustment mode changes from muted to un-muted, all other 
Group members (regardless of their state) become un-muted.  If the Mute pressed changes from un-muted 
to muted, all other members of the Group become muted.

Expert Temporary Adjustment Mode
Whether the adjusted faders snap back to their original positions or all the untouched group members jump 
to the positions dictated by the moved fader is now determined by which is released first: the - button or the 
Fader.

- Button First

Release the - button while holding a Fader and all the grouped faders will now jump to reassert the group 
relationship but according to the fader level you are holding.

Fader First

Release the Fader and now release the - button and all the faders jump back to the positions they were in 
before you hit the minus key.

mod - modifier Change
Whilst in Group mode, pressing the mod button toggles through the three different Grouping targets: Fad-
ers, Mutes and Others.  With each press each mode’s respective indicators are lit and the Meter Bridge 
indicators of all members of all groups of this type are displayed.

Expert Grouping Mode
Whilst in Grouping Mode, and having selected a Group, pressing both the + button and the - button at the 
same time enters Expert grouping mode.  In this mode both Addition and Subtraction from the group is 
possible.  This mode can be applied to all grouping targets and all other normal grouping rules apply.

Group button indicator
The Group button indicator is lit whenever the console is in any grouping mode.  This is initiated by hitting 
the Group button.

Tips and tricks
• To Group two Faders together (providing they are not already in a Group), simply hold the two fad-

ers you wish to Group - and tap the group button twice.  The Faders are now grouped
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• To recall a Group and all its faders onto the surface, press recall, then group and then touch a 
Fader being part of the desired Group, all the Faders belonging to this Group are now in front of 
you. 

15 Subtract from Group button (-)
In Grouping Mode
When in Grouping mode, pressing the - button initiates a 'remove from an existing group' mode.  (Please 
see: 14 Group button  on page 45) for more details.

Expert Grouping Mode
In Grouping mode, the - button, when pressed together with the + button, initiates Expert Grouping 
Mode.  In this case both + and - indicators are lit and addition as well as subtraction from the currently 
selected group is possible.  Please see Expert Grouping Mode  on page 47 for more details.

Temporary Adjustment Mode
The - button can also be used to initiate a 'temporary adjustment' mode.  This mode allows controls to be 
moved independent of group laws.  It is initiated by holding down the - button whilst not in Group mode.  
Please see: Temporary Adjustment mode  on page 47  for more details.

- button indicator
The - button indicator is lit under three conditions:

• Whenever the console is in 'Remove From Group' Mode.  This is initiated by hitting the - button 
after hitting the Group button.

• Whenever the console is in Expert Grouping Mode.  This is initiated by holding down both the - 
button and + button at the same time whilst in Grouping mode.

• Whenever the - button is held down whilst not in Grouping mode.  This temporarily suspends 
grouping laws allowing control of elements such as Faders or Mutes, independent of group control.

Please see item 14 Group button  on page 45 for more details on these modes.

16 Faders, Mute & Other indicator
The Faders indicator is illuminated whenever the grouping mode is active and Faders have been selected 
as the grouping target.

See item 14 Group button  on page 45 for more details of the Group modes.

The Mutes indicator is illuminated whenever the grouping mode is active and Mutes have been selected as 
the grouping targets.

Please see item 14 Group button  on page 45 for more details on these Group modes.

The Others indicator is illuminated whenever the grouping mode is active and refers to Others.  

After entering group mode, if a control such as an EQ or AUX is touched, the target of the grouping func-
tion changes to that control.  The indicator will now illuminate and remain lit until a Fader or Mute is touched 
to specify an alternate grouping target, or group mode is exited, either through pressing group again, or 
Solo Clear to escape. It also can be anything on the Active screen.

17 Release time knob
Fader release time controls glide back when a Fader is released during automation. 
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This is a rotary control (non-automated) that determines the speed at which a fader glides back to it's previ-
ously automated position after having been released (when in release mode). When set to low (knob is 
turned to the left) a Fader will take 0ms to return to its automated position after being released (the same 
as snap for all practical purposes). When turned to the right, it will take 10 seconds (10,000ms) to return to 
its previously automated value after being released.

18 snap button
Invokes the Pyramix automation Snap release mode. The current value snaps back instantly to the value 
written in the previous pass when the control is released.

The button lights when the mode is engaged. Please see the Pyramix V6 User Manual for more details.

19 release button
Invokes the Pyramix automation Auto-release mode. The current value morphs to the value written in the 
previous pass when the control is released at a rate determined by the release time knob. 

The button lights when the mode is engaged. Please see the Pyramix V6 User Manual for more details.

20 next button
Invokes the Pyramix automation Write to Next mode.  Writes automation until the current value matches 
automation data written in the previous pass then it releases automation into read.

The button lights when the mode is engaged. Please see the Pyramix V6 User Manual for more details.

21 end button
Invokes the Pyramix automation Write to End mode. The button lights when the mode is engaged. Please 
see the Pyramix V6 User Manual for further details.

Note: At any time while writing automation you can set another release mode providing 
Stop has not been pressed.

22 trim button
Invokes the Pyramix automation Trim mode. The button lights when the mode is engaged. Trim mode 
operates an a “Touch” basis. So long as you are touching the desired fader (or other encoder) trim mode 
remains engaged. As soon as the fader is released the current release mode is activated. Please see the 
Pyramix V6 User Manual for details.

Note: The orange TRIM LED adjacent to the fader is lit when Trim is active.

23 hold button
The encoder currently touched will be held until released The button lights when pressed. 

Note: The purple HOLD LED adjacent to the fader is lit when Hold is active.

24 snapshot
Produces an automation snapshot (keyframe) of all touched encoders or, if inject  is touched, for the 
whole strip(s) of the current values at the Play cursor position.
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25 snap range
This is similar to the snapshot function except that it operates over a range determined by a Region 
Selection or In and Out Markers within the Pyramix application. Please see the Pyramix V6 User Manual 
for details.

In the future (Pyramix V6.1) it will be possible to set these markers from within the Transport and Automa-
tion Active Screen.

26 Mute 
Works as a normal mute button (used with inject) but is especially useful as modifier button 
when used in conjunction with the optional ARC. The mute button indicator is lit whenever the 
button is pressed.
Press and hold the Mute Modifier button while wiping the ARC either mutes or un-mutes those channels 
using the following rules.

27 unity button
Press and hold unity and wipe over inject button. This will restore your faders to unity gain. You can do 
the same with EQ's and other Ramses parameters.

Tips and Tricks
• Press and hold unity then press ALL restores the entire console (faders) to unity.

28 arm button
Hold arm and wipe over inject button. This will track arm your edit tracks (red indicator at the bottom of the 
channel Vu meter and red outline in the Meter bridge) . 

Note:  Tracks can only be armed when they have an input connected to them.  

Tips and Tricks
• If you press and hold arm then press ALL then all available tracks with inputs will track arm or dis-

arm.

mute with ARC
Touching an ARC Segment with mute held down not only changes the mute 
state of that strip but also loads this change of state into memory and applies it to 
all other Segments touched while the button is held down.

E.g. If the first segment touched is muted, this Segment will be un-muted and, if 
you continue to wipe along the ARC all muted channels touched will be un-muted 
whilst strips already un-muted are unchanged.

If the first Segment touched is un-muted, this Segment will become muted and all 
subsequent Segments touched will either become muted, or if already so, remain 
muted.

I.e. The first strip you touch determines whether you're modifying things to turn 
ON or to turn OFF.
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29 m1 & m2 buttons
These are two "clipboard" memories. E.g. if there is a EQ curve that you wish to copy to another channel.  
hold m1 and press the EQ button on the desired strip. Then press and hold m1 and inject it into the 
desired destination channel(s).

Tip and tricks
• Any type of value can be stored in these memories. While pressing and holding m1 you can move a 

fader or any type of rotary control and, so long as you don't release the m1 button, all those param-
eters will be stored in m1.

• In the future the library button above the Active Screen will offer many more memories.

30 isolate button
Automation
Holding down the Automation isolate button and then injecting any fader will change the state of the 
selected strip to automation Isolate Mode (or just the section(s), EQ, Dynamics, AUX etc. if you touch 
them in the Active Screen).

Strips selected using this mode remain in Automation Isolate mode until another mode is selected for them.

While the isolate button is held down, the Meter Bridge indicators display all channels currently in Isolate 
if automation feedback is activated in the Meter Bridge configuration. Please see: Automation Fader 
Mode  on page 85

Isolate button indicator
The Automation Isolate indicator is illuminated when the Isolate button is pressed.

31 read button
Automation
Holding down the Automation read button and then injecting any fader will change the state of the selected 
strip to automation read Mode (or just the section(s), EQ, Dynamics, AUX etc. if you touch them in the 
Active Screen).

Strips selected using this mode remain in Automation Read mode until another mode is selected for them.

While the read button is held down, the Meter Bridge indicators display all channels currently in isolate if 
automation feedback is activated in the Meter Bridge configuration. Please see: Automation Fader Mode  
on page 85

Read button indicator
The Automation Read button indicator is illuminated when the Read button is pressed.

32 write button
Automation
Holding down the Automation read button and then injecting any fader will change the state of the selected 
strip to automation write Mode (or just the section(s), EQ, Dynamics, AUX etc. if you touch them in the 
Active Screen).

Strips selected using this mode remain in Automation Read mode until another mode is selected for them.
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While the read button is held down, the Meter Bridge indicators display all channels currently in write if 
automation feedback is activated in the Meter Bridge configuration. Please see: Automation Fader Mode  
on page 85

Read button indicator
The Automation Read button indicator is illuminated when the Read button is pressed.
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31/32 Auto Write
Automation
Holding down the Automation read and write buttons together and then injecting any fader will change the 
state of the selected strip to automation read Mode (or just the section(s), EQ, Dynamics, AUX etc. if you 
touch them in the Active Screen).

Strips selected using this mode remain in Automation auto-write mode until another mode is selected for 
them.

While the read & write buttons are held down, the Meter Bridge indicators display all channels currently in 
auto -write by lighting both read and write indicators if automation feedback is activated in the Meter 
Bridge configuration. Please see: Automation Fader Mode  on page 85

Auto Write buttons indicators
The Automation Read and Write button indicators are illuminated when the Read and Write buttons are 
pressed.

Tips and tricks.
• You can have two automation status options, set in the Active Screen System > Configure menu. 

One is  single automation status per channel. I.e. Wherever you touch, the fader or inject will 
change the automation status for the entire channel. The second option is per section. If you 
change the automation status and e.g. touch the fader or the EQ button, the automation status only 
changes for those elements touched. If you wish to change the status for the entire channel then 
use inject. 

Note: The automation LED adjacent to the fader indicates the automation status for the 
fader ONLY in the second mode.
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• Automation status feedback on active screen

33 & 34 channel nudge buttons
Navigation
Nudges the virtual strips to slots assignment one place to the left or right. Fader strips that are in Hold 
mode remain unaffected.

35 & 36 bank nudge buttons
Navigation
Nudges the virtual strips to slots assignment one bank (8 fader strips) to the left or right. Fader strips that 
are in Hold mode remain unaffected.

37 Aux button
Navigation
Forces the aux bus masters  onto physical fader strips. Fader strips that are in Hold mode remain unaf-
fected.

auto-write dynamics

auto-write Pan Surround

auto-write Outputs

isolate Equaliser

read   Fader

auto-write Groups

auto-write Aux Sends

auto-write Plugins

isolate Input

Automation indicators - Active Screen
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38 Mix button
Navigation
Forces the mix bus masters  onto physical fader strips. Fader strips that are in Hold mode remain unaf-
fected.
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7 Upper Active Panel
Upper Active Panel
Overview
1.    timmometer knob

2.    scene button
3.    template button
4.    personal button
5.    system button
6.    auto button
7.    library button
8.    safe button
9.    plug-ins button
10.  machine button
11.  monitor button
12.  more button
13.  even more button
14.  daw 1 button
15.  daw 2 button
16.  daw 3 button
17.  daw 4 button
18.  Active Screen
19.  dual-concentric encoders
20.  active dual-concentric encoders
21.  active button

9

11

14

10

876

542 3

13

1

12

171615

18

202120

19 19

Upper Expert Panel
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1 timmometer knob

2 scene button

3 template button

4 personal button

5 system button

6 auto button

7 library button

8 safe button

9 plug-ins button

10 machine button

11 monitor button

12 more button

13 even more button

14 daw 1 button

15 daw 2 button
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16 daw 3 button

17 daw 4 button

18 Active Screen

19 dual-concentric encoders

20 active dual-concentric encoders

21 active button
 Upper Active Panel 7 - 58



Ramses MSC reference guide
Lower Active Panel : Expert Panel Overview
8 Lower Active Panel

Lower Active Panel
1. mod button

2. Ø phase reverse button
3. solo button
4. clear touch point
5. strip number display
6. a/b button
7. insert button
8. mute button
9. zoom button
10. grp - bus 1 - 24 select buttons
11. mix - cut surround channel buttons
12. mix - bus A - F select buttons
13. pan joystick panner
14. L & R panner select buttons
15. transport controls
16. locate buttons

10

12

15

11

876

5

42 3

14

1

13

16

9
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1 mod button

2 Ø phase reverse button

3 solo button

4 clear touch point
Overview
Touching the Solo Clear touch point (which is also the Solo Master indicator) clears any and all currently 
active solos.  It is functionally identical to the Solo Clear touch point on the Expert Panel (Please see item 
5 Solo Clear touch point  on page 41)

Normal Operation
If any channel is solo-ed the Solo Master indicator will be lit. Now, when touched, all solos will be removed, 
all channel Solo indicators extinguished, the Solo Master indicator itself will be extinguished and the moni-
tors resume their normal monitoring mode.

Additional Functions
The Solo Clear touch point also acts as an escape style command for various different modes.  When 
touched while in Grouping Mode, it exits Grouping Mode and reverts to the group states before Group 
Mode was entered. Similarly in Ergonomic Spreads Store Mode, when pressed the Store mode is 
cleared.

Solo Master indicator
The Solo Master indicator is illuminated if any channel is solo-ed.

Note: This control has two functions.  It's indicator functions as a Solo Master indicator, 
while it's Touch Control functions as a Solo Clear.

Tips and Tricks
The Solo Clear touch point also acts as an 'escape' style command for various different modes.  When 
touched while in Grouping Mode, it exits Grouping Mode and reverts to the group states before Group 
Mode was entered. Similarly in Ergonomic Spreads Store Mode, when pressed the Store mode is cleared.

5 strip number display
Displays the number of the strip currently being controlled by the Active Panels 

6 a/b button

7 insert button
Bypasses the physical insert on the channel (future release)

8 mute button
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9 zoom button

10 grp - bus 1 - 24 select buttons

11 mix - cut surround channel buttons
See 12 below

12 mix - bus A - F select buttons
mix bus A - F buttons select a given bus’s stem.  The LEDs above each Mix Bus button display the cur-
rently selected bus-stem.  Once selected, you can use the mix - cut  buttons to determine which channels 
of that stem you wish to send your signal to, simply by pressing the mix - cut buttons.  Lit buttons indicate 
that the signal is being sent to this channel (the level is determined by the panner and fader).  Unlit buttons 
indicate that this signal is not being sent to this channel.

13 pan joystick panner

The joystick can be used to pan in surround space. I.e. LCR and FR or, by using the  L & R buttons it can 
be locked to horizontal or vertical axes. Panning can also be locked for the strip.

14 L & R panner select buttons
Pan Locking
The L - R buttons allow you to do the following depending on the combination:

• L - locks the pan to horizontal LCR panning

• R - locks the pan to vertical FR panning

• L+R locks all panning for the strip

Indicators lit when mode selected.

15 transport controls

16 locate buttons
 Lower Active Panel 8 - 61



Ramses MSC reference guide
Pyramix Monitor Section : Monitor ! Window
9 Pyramix Monitor Section

Monitor ! Window

Scope
Pyramix has a dedicated Monitor section. This extremely powerful tool offers comprehensive monitoring 
facilities including summing and downmixing for all supported formats. External Machine Inputs, comprehe-
sive Talkback, Foldback and External Metering are also supported depending on your system specification.

The Monitor presents monitor outputs of all buses present in the current Mixer as sources. It is also possi-
ble to configure external sources both for recorder returns and for talkback. Sources can be summed for 
monitoring without affecting the Mixer bus outputs. This is useful, for example, when you need to listen to a 
guide track while recording. 

You do not have to use the Monitor and disabling it will save DSP power but, with complex Mixers and 
routing, the Monitor helps to keep things logical.

The monitor is also used to output the audio signal from the audition function of the Media Manager and 
Libraries as an unformatted input. (I.e. Routed to LRC in a Surround 5.1 Speaker Set and to LR in a Stereo 
one)

By default the Monitor window is hidden. It can be opened with View > Monitor or the  icon in the 
View Toolbar. 

The Monitor has four pages: a Main Monitor ! page in normal operation, a Configure page for setting up 
and two further pages for configuring Externals (machines) and Talkback.

Monitor Main Monitor !  Window
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Monitor ! page

The Monitor ! window is divided vertically into three sections.

Sources, left-hand section:
The button top-left of the title bar enables/disables the Monitor and lights yellow when enabled. This allows 
DSP power to be saved when comprehensive monitoring control is not required. Below the Enable Moni-
toring button is a tree view of all busses used in the mixer. Clicking on the + and - boxes shows and hides 
branches in the usual way. Click on any complete bus or any available stem or any bus/stem channel to 
select it for monitoring. Selection is exclusive unless the Ctrl key held is down. Then selection is cumula-
tive and clicking adds or subtracts Sources according to their current state.

Buses / Externals button
Note: At bottom left in the screenshot above the button labelled Buses indicates which 
sources are available for activation. Clicking on this button toggles through Buses, Exter-
nals and Buses / Externals

Main, centre section:
Selected Sources
<<      SR1     >>: Select previous/next Pyramix source. Only sources visible in the Sources section are 
available. I.e. If the component channels of a bus or stem are collapsed this bus or stem is switched as a 
unit when the component channels are visible in the Sources section then clicking on the << or >> buttons 
steps through each available channel in turn.

<<     DA-88   >>: Select previous/next External Source. Only External Sources visible in the Sources sec-
tion are available.

Note: Clicking on any of the << or >> buttons cancels the selection made previously in the 
Sources section.

Selected Output
<< Surround 5.1 >>: Select previous/next Speaker Set. 

<<       Main       >>: Select the previous/next Downmix defined in the Configure page.

Main area
Speakers are inactive (grayed) if they are not connected in the Configure page.

The Mode buttons at the bottom determine the function of the active Speaker buttons.

Mute: Clicking on a speaker mutes it. Selections are cumulative.

Solo:  Clicking on a speaker solos it. Selections are cumulative.

SoloX: Solo eXclusive on the clicked speaker. Selections toggle.

Phase: Clicking on a speaker reverses its phase. Selections are cumulative. Useful for quick imaging 
checks.

In Place Works in conjunction with Solo and SoloX. Toggles between In Place and Center.

Reset: Deselect all speakers.
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In Place/Center: In Solo and SoloX, toggles between In Place and Center. Center routes the soloed 
channel(s) to the Center speaker or equally to the L/R speakers if no center speaker is present. In Place 
mode is the normal Solo, SoloX mode.

Output, right-hand area
Monitor Level box Displays the current output level. Output level can be entered numerically in the box 
after clicking on it. 

Volume Knob: sets all the output gains in a range from -144.5dB to +24dB. Double-click to set it to 0dB.

Note: Maximum permissible volume can be set in the Configure page. 

Mute: button mute the outputs.

Dim: button reduces the output level by an amount set in the Configure page. Default value is -20dB.

Below these buttons is the

Peak Meter Selection: Indicator/Button. This indicates what the Peak Meter display below the button is 
looking at. (The selection also affects External Metering if you are using it) Clicking on the button drops 
down a list of sources that can be metered from a choice of Master Output I.e.Monitor Output, Mixer 
Buses and any available Externals. 

Speaker Sets
Speaker Sets are set-up in the Configure page.

A speaker set consists of:

A Patch: This connects signals to the physical outputs of the board(s). The number of connection will 
depend on the number of speakers you want to connect. Since the number of available live outputs 
depends on the selected sampling rate, the patch will differ for 1Fs, 2 Fs, 4Fs and 8 Fs sampling rates.

Monitor Main Monitor !  Window Peak Meter Selection drop-down
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A Main grid: this matrix defines the relation between the Mixer’s busses output channel types and the 
monitor’s output channel types (thus the monitor’s physical outputs). Typically, the main grid would show a 
diagonal for the channel types patched:

A set of Downmixes (max: 4) : A downmix is a an alternative grid which uses the same patch as the main 
grid. In this page you can patch the outputs of you monitor, add/remove downmixes, and defines the corre-
sponding grids in dB (only the channel types which are patched).

Monitor Configure Window
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Configure page

The Configure page enables multiple Speaker Sets, each with multiple down-mixes, to be created and 
edited. Two factory Speaker Sets (Stereo and Surround 5.1 labelled on a red background at the top of the 
Speaker Sets list) are installed with Pyramix. Their Main channel to speaker Main Grid and Down-Mix 
assignments cannot be changed, but their output Patches from speakers in the Monitor to physical outputs 
can. They and each of their down-mixes can be enabled/disabled in order to determine which ones are vis-
ible in the main Monitor page.

The Configure page is divided into four main areas; Speaker Sets and Down-Mixes, Available Sets, 
Output Speakers Patch and Delay[ms], Main Grid and Down-Mixes and Output Metering Patch.

Available Sets
To select an existing Speaker Set in order to view or alter its settings, click on its title in the Available Sets 
list. The label will become underlined and the Set’s parameters will appear in the grid. If the Set has Down-
Mixes already defined there will be one or more tabs next to the Main Tab in the Main Grid and Down-
Mixes area.

Monitor Configure Window
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Two sets, Stereo and Surround 5.1 are factory defined and cannot be altered. New Sets and Down-Mixes 
can be Created, Duplicated and Deleted using the Command buttons.

Max Vol
To set the maximum volume attainable click on the value box to highlight it and type the desired value then 
hit Enter or click elsewhere on the window to save the change.

Dim Value
To change the Dim Level, click on the value box to highlight it and type the desired attenuation value then 
hit Enter or click elsewhere on the window to save the change.

Note: Only negative values are accepted. Positive values revert to 0dB. I.e. Type “-15”

Commands
Speaker Sets
New Set
Clicking on New Set creates a new Speaker Set with a blank matrix Grid and adds a new entry to the Avail-
able Sets list with the label highlighted ready for text entry:

Type a suitable name and click on a blank area or hit ENTER to accept the name.

Duplicate Set
Creates a new Speaker Set with a the same matrix Grid settings and Down-Mixes and settings as the set 
currently selected (underlined) and displayed in the grid. The new label is highlighted ready for text entry.

Delete Set
Deletes the currently selected (underlined) Speaker Set.

Down-Mixes
Add Down-Mix
Creates a new Down-Mix associated with the currently selected Speaker Set with a new tab in the Main 
Grid and Down-Mixes section.

Remove Down-Mix
Deletes the current Down-Mix

Monitor Configure New Speaker Set
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Output Patch:
This is where the Monitor’s Speaker Set outputs are patched to physical outputs.

Clicking on a cell pops up the Set Output Connection menu with all available physical outputs grouped by 
their connectors. The sub-menus list the group and the individual channels. Select an individual channel to 
connect it or select the group, e.g. AES/EBU (#11291) Front to connect the whole group in ascending 
order from the cell clicked on.

Note: Each Speaker Set has its own Output Patch associated with it. This is useful where 
different speakers are used for different formats. If there is only one set of speakers patch 
all Speaker Sets to the same physical outputs.

Double Assignment
When an output of the Mixer and an output of the Monitor are connected to the same physical output then 
these are summed and the Mixer displays the connection in orange as a warning.

Speaker Delays
Delay can be set per Speaker by clicking in the box below the Output Connection and typing in a value. 
Speaker delays are typically used to compensate for the physical positioning of the loudspeakers for exam-
ple where the Left Centre and Right speakers are placed in a straight line, the Centre speaker will be 
nearer to the listening position and should be delayed accordingly. 

Saving Speaker Sets
Mixer to Monitor connection status is saved in the project.

The Speaker Set settings are saved when you leave the page to go back to the Monitor ! page; otherwise, 
modifications are not saved.

Monitor Configure Output Patch
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Media Manager Monitoring

Note: In order to be able to audition cues in the Media Manager the L and R None entries 
in the Main Grid matrix must be set to a value, e.g. 0.0

Monitor Configure Media Manager
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External Metering

If you wish to use your favourite external hardware meters with Pyramix this can be achieved easily and 
conveniently. 

At bottom right of the Monitor Configure page an extra set of nine patches is provided to configure exter-
nal outputs specifically for metering.

Patches are made in exactly the same way as the Speaker Output Patches. Please see: Output Patch:  
on page 68

Monitor Configure Output Metering Patch
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External Inputs

External devices may be added in the Monitor panel. This is useful for connecting monitoring returns from 
the Studio’s fixed external audio devices such as recorders. 

Note: This feature is currently available for Native, Mykerinos mono-board and MassCore 
systems. It is not currently supported on Mykerinos multi-board non MassCore systems.

Adding an External Machine
Up to 8 new externals can be added. 

Note: External machines will only be visible and available as monitor sources in the Moni-
tor !  page when the Buses /Externals button is set appropriately. Please see: Buses / 
Externals button  on page 63

Each external has a dedicated input Patch. Patches are set up by clicking in the boxes below the speaker 
letters and choosing inputs from those available.

Monitor Externals page
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Talkback

Talkback facilities are provided in the Monitor section for studios without a separate talkback system.

These facilites are intended to be used with GPI/O external connections for physical talkback switches.

Please see: the main Pyramix User Manual, GPI/GPO Support for information about setting up GPI/Os.

Note:  Talkback is currently available for Native, Mykerinos mono-board and MassCore 
systems. It is not currently supported on Mykerinos multi-board non MassCore systems.

When Talkback is set up and active the Talkback section appears at the bottom of the main Monitor ! 
page:

Monitor ! page with Talkback Section
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Setting Up

Talkback Page
You can add up 8 Studios (Destinations) and 3 Talkbacks (Sources) in the Talkback page:  

Destination
Add Adds a Destination

Delete Deletes the selected Destination or the remaining one when there is only one shown.

Source
Add Adds a Source

Delete Deletes the selected Source or the remaining one when there is only one shown.

Record reset latch
When lit red all active conversations are muted when the transport is in Record.

Play reset latch
When lit green all active conversations are muted when the transport is in Play

Stop enable talk to all
When lit yellow the Talk To All function is activated when the transport is in Stop.

Monitor Talkback page
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Example
This is how you would set up talkback for a simple facility with a Mix Room, Studio and Machine Room.

• The Mixer will be able to speak to the Vocal Booth or the Machine Room independently.

• The Assistant will only be able to speak to the Mix Room. 

• The Vocal Booth will only be able to speak to the Mix Room. 

Note: If a seperate ‘Producer’ Talkback unit is required this can be achieved with a simple 
parrallel physical connection of buttons that both activate the Mixer to Vocal Booth GPI.

Setting Up
1. Click on Studio Add

A New Monitor Studio box appears. Type a suitable name for the Studio, in this case, Vocal Booth 
and press the keyboard Enter key to confirm.
The red button indicates that the destination is active. 

Note: The Talkback section will be shown at the bottom of the Monitor ! page if any desti-
nations are active in the Talkback page.  

2. Notice the two boxes to the right of the name with orange dashes. Click on the left box to drop down the 
Set Output Connection menu:  

3. choose a suitable physical output to feed the Talkback amplifier/loudspeaker.

Note: If you only have digital outputs then you will need a converter.

Monitor Talkback page Destination Output  Connection
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4. If you wish to have stereo talkback/foldback repeat steps 2&3 for the right-hand box. Here only the 
Vocal Booth is to be fed with Foldback so that is the only stereo destination.

5. Repeat steps 1 to 3 twice to add two more destinations.

6. Label these to suit, in this case, Mix Room and Machine Room.

You should now have something like this on screen: 

Note: Only the Vocal Booth has been set up as a stereo destination. If you want seperate 
speaker and headphone feeds to the studio just add another destination and label it appro-
priately. E.g Vocal Booth HP for maximum control.

7. Now set up the sources by clicking on Source Add

8. A column appears with New Talker highlighted in a box. Type a suitable name for the source. In this 
case Mixer.

Monitor Talkback page with destinations
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9. Add two more sources and label them Assistant and Artist 

10. Click on the boxes with the orange dashes at the bottom of each source column to open the Set Input 
Connection menu and choose a suitable input connection for each of the talkback microphones. 

Note: If you only have line level analogue inputs you will need external mic pres and if you 
only have digital inputs then you will need converters as well.

11. Now the levels, Dim and Mute switching must be set. 

• The boxes in the first column of each Source set the attenuation that will be applied to the 
Destination output when Talkback is activated from each source.

• The second column sets the send level per Destination. You can type mute or a numeric 
value in the box.

Note: If mute or -144.5 is entered this Destination will be grayed out and unavailable in 
the Talkback section of the Monitor page. For example, it is illogical for the Mixer Source 
to talk to the Mix Room Destination and so on.

• The third column offers the choice of Dim or None. Selecting Dim means that when this cros-
spoint (Source to Destination) is activated by pressing the relevant Talk button, the Main 
Monitor Output will be dimmed.

Note: This is essential when, for example, the Mix Room talks to the Vocal Booth with the 
programme mic channel open to avoid howl-round and possible damage to loudspeakers 
and hearing.

Monitor Talkback page with Sources and Destinations
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• The fourth and final column offers a choice between Rec Free and Rec Loc. 
Rec Free means that talkback on this crosspoint can be initiated when the Transport is in 
Record and the Record Reset Latch is set. 
Rec Loc disables the crosspoint when when the Transport is in Record and the Record Reset 
Latch is set.

So, bearing in mind who is going to be allowed to talk to whom and given that it is illogical to use talkback to 
talk to yourself, the levels should now look approximately like this: 

Returning to the Monitor ! page you will see this in the Talkback section: 

(If the buttons on the left are lit blue ignore them for now) The big buttons with the labels Mixer, Assistant 
and Artist are  Talk to All destinations (In this case only relevant to Mixer)

Monitor Talkback page with Sources and Destinations and levels set

Monitor ! page  Talkback Section
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Operation
The smaller buttons vertically below the bigger, labelled Source buttons initiate talkback from the horizontal 
sources to the vertical destinations. These are the buttons you are most likely to want to map to GPIs. For 
example in the following screenshot the Mixer is talking to the Vocal Booth:  

Note: Notice that, due to the settings made earlier, Mixer talking to Vocal Booth also 
Dims the Main Monitor Output.

Talkback Button Operation
All the Talkback buttons are dual mode. A press of less than one second latches the Talkback open. A sec-
ond press cancels. A press of more than one second initiates Talkback on press and cancels when the but-
ton is released.

Reset cancels all latched talkbacks.

Talk to All initiates open Talkback between all enabled Sources and Destinations

Monitor Talkback page : Mixer talking to Vocal Booth
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Foldback
Continuing the foregoing Talkback  example it is also possible to add foldback to the Talkback outputs. To 
add Foldback to the Vocal Booth Talkback outputs click on the black box to the right of the Vocal Booth 
label to drop-down a list of available Foldback sources: 

Select the required Foldback Studio Monitor Source.

Note: You can add a bus in the mixer specifically to produce a mix for Foldback.

The buttons on the left of the Vocal Booth label etc. toggles the foldback on and off per destination: 

Here, the Vocal Booth is fed with ST1 (Main)  bus output. The vocals are recorded clean on M1 (Mono 
Mix) and, as can be seen above, the Mixer Room monitors are being fed with the sum of these buses.

Monitor Talkback page : Select Foldback Source

Monitor Talkback page : Foldback  to Vocal Booth Active
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10 Meter Bridge

Scope

Ramses MSC takes full advantage of the Pyramix dedicated Meter Bridge window. 

The Meter Bridge can present a meter display for every Input strip and Bus present in the current Mixer 
and external Machine configured in the Monitor : Externals page.

The Meter Bridge also indicates the currently selected mixer strip with a yellow outline, any strips in 
Record Ready condition with a red outline, whether any strips are Muted or Soloed and optionally shows 
Ramses Groups and Fader Automation mode per strip.  

You do not have to use the Meter Bridge but, especially when used with Ramses MSC, it offers flexible 
metering in one place. With complex Mixers and routing, the Meter Bridge can help to keep things logical.

Note: The Meter Bridge is displayed “Always On Top” of other windows.

Meter Bridge Switch

Before the Meter Bridge Window can be opened it must be switched on in the Settings section of the Pyra-
mix Mixer Configure Page : 

Meter Bridge Switch
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Meter Bridge Window

By default the Meter Bridge window is hidden. It can be opened with View > Meter Bridge or the icon in 
the View Toolbar. 

Meter Bridge  Window - Triple Row Mode
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Resize
The Meter Bridge Window can be resized by clicking and dragging the edges. (Mouse cursor changes to 
double arrow) Vertical resizing is limited to sensible display options. Scroll bars will appear when there is 
more information to display than the window can accomodate.There is a separate auto-hide scrollbar for 
the Input Strips so you can keep all the Buses and Externals visible together with a contiguous section of 
the Input Strips of a very large mixer. (This will appear when the mouse cursor is over the right-hand edge 
of the top two rows.)

Global Mute and Solo Indicators
If any strip is Muted or Soloed the global indicators in the left margin illuminate.

Selected Strip and Record Ready Status
The currently selected strip is shown with a yellow outline.

Any strips currently in Record Ready mode are shown outlined in red.

Configuring the Meter Bridge
When first opened the Mixer Bridge appears as above. clicking on the double arrow >> below the Yellow 
Activate button opens the Display panel (a subsequent click on the << arrows closes): 

Layout
The three buttons determine whether the meters are displayed as a single, double or triple row (default).

Meter Bridge Configuration : Display Section
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Single Row
Single row is useful if you only wish to display buses and or Externals (returns).

Strips
The red button shows/hides the Input Strip Meters (default is Show)

Note: Show/Hide for Input Strips is only available in ‘single row’ display mode. Useful in 
applications where the Bus and External Machines are of more interest than the Inputs.

Pre-Fader
When lit, the Input Meters source is taken pre-fader. (default is post-fader)

Automation
When lit, four Fader Automation Mode indicators are shown in each Input Strip. (default is hidden)

Buses
The red button shows/hides the Bus Strip Meters (default is Show)

Pre-Fader
When lit, the Buses Meters source is taken pre-fader. (default is post-fader)

Externals
The red button shows/hides the External Machines Meters (default is Show)

Note: Externals, External machine Returns, are set up in the Pyramix Monitor : Exter-
nals page.

Meters Zoom
The slider adjusts the meter scaling. Range is from 0dB to -144.5dB maximum to 0dB to -10dB minimum.

Double-clicking on the slider ‘knob’ resets to default scaling. 

Meter Bridge - Single Row Mode
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Meters Type
The drop-down offers a choice between Peak (default), VU or Peak + VU as seen here along with the 
Automation Indicators: 

Meter Bridge - Triple Row Mode
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Automation Fader Mode and Group Indicators

Ramses Group

This indicator shows that the associated strip is a member of a Ramses MSC control Group. When in 
inverse video (filled in) it also indicates that the associated strip is a member of the currently selected strip’s 
Group.

Note: These Ramses MSC Control Groups are currently completely independent of the 
Pyramix grouping arrangements.

Automation Fader Mode

In the default, Auto-Write, mode only the Write and Read indicators are lit together.

As soon as a fader is touched with the transport in play the Read indicator extinguishes leaving only the red 
Write indicator lit.

If an Automation Trim mode is selected the yellow Trim indicator will also be lit.

Similarly, if a Hold mode is selected the purple Hold indicator will be lit.

Thus, in the Meter Bridge screenshot above, the automation is in Auto-Write plus Trim & Hold modes.

Member of Group

Member of selected
Strip’s Group 

Write

Read

Trim

Hold
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11 Edit Bay

Introduction

Scope
The edit bay will function as described in this document, although please bear in mind that functions will be 
added in the coming months to arrive at the full functionality of Edit Bay as labelled on its surface. 

We have developed workarounds for the few remaining functions not yet available.

All functions NOT described in this quick start guide are already fully functional as they will be in the final 
version. Please refer to the labelling on the Edit Bay surface and to the Pyramix 6.0 user manual for the 
specifics.

Software Versions
Important Note: 
It is ESSENTIAL to have the following versions of software or later to avoid unpredicatable 
operation:

• Pyramix Version 6.0.4 Pre RC1 build 323

• Ramses Consolesoft 1.5.3 3709    14th November 2007

• Edit bay Consolesoft set2    21st November 2007

Please refer to the Ramses update guide and Pyramix 6 Installation Guide for guidance on how to install 
those updates.
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General Overview

1. View Select and Modifiers; These keys open Pyramix Windows and dialogs such as All Settings and 
the Fade Editor or Library Tab Windows. In a later iteration of software the Editor will have the focus 
on those windows when they are opened.

2. Transport Control; This is the same as theTransport Control panel on the main Ramses MSC surface 
with the same functions available.

3. Track Selection and User keys; these keys are used to select a Track, or to Mute, Arm etc. a track 
depending on which Modifier they are temporarily assigned to. It is closely linked to the above VCD 
(alphanumeric feedback) and will be in the future available for User Defined Macros and Functions.

4. Editor; all the functions needed to edit quickly and efficiently are labelled on the surface. The big but-
tons at the bottom of the panel are used to select the Jog Mode and Modifiers (Ctrl, Alt etc) to provide 
greater functionality. When the Modifiers are pressed and held the available functions will light up on 
the editor.

Ramses MSC Edit Bay Panel

42

3
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The Editor

Note: ONLY FUNCTIONS WHICH ARE NEW AND NOT FULLY OR PARTIALLY IMPLE-
MENTED (WORKAROUNDS) WILL BE DESCRIBED

Navigation

You can navigate independently OR with the Ramses fader/strips navigation.

When loc -bank is disabled you will navigate in combination with the Ramses fader strip navigation. The 
right-most eight faders will also be the Edit Tracks shown on you VCD available for Selection and Editing. 

When loc-bank is enabled navigation around the Edit Tracks is independent of your Ramses.

Note: Please remember that in order for the Navigation keys on the Edit Bay to work you 
must enable loc-bank.

trk-sel - press and hold to use the jog wheel to navigate through the Edit Tracks

< bank- each time you depress the VFD shows the previous eight Edit Tracks

> bank- each time you depress the VFD shows the next eight Edit Tracks

prev- not yet implemented. Jumps to previous Edit Track layout 

Note: You can also touch a fader on Ramses and the corresponding Edit Track will be 
highlighted automatically. Another way of navigating is to use the up and down arrows to 
move from one Edit Track to the previous / next.

Edit Bay Panel Navigation area
 Edit Bay 11 - 88



Ramses MSC reference guide
Edit Bay : The Editor
Modifiers - Left-hand Side

lay-all not yet implemented

lay-prim not yet implemented

solo when pressed the small Track Selection and User Keys will 
toggle Solo on the Edit Tracks

mute when pressed the small Track Selection and User Keys will 
toggle Mute on the Edit Tracks

loc- bank Toggles linking navigation to Ramses main fader navigation

trk-arm when pressed the small Track Selection and User Keys will 
toggle Track Arm on the Edit Tracks

Modifiers - Right-hand side

trans not yet implemented

snap enables Snap Head to Nearest. CTRL + snap disables Snap 
Head to Nearest

update-tc Updates the original TimeCode of the actual composition to 
the original medias. Use with caution!

auto-x toggles auto cross fade enable/disable

auto-rip toggles auto-ripple (shuffle) enable/disable

auto-sel auto selection mode (Clip - and Clip group - under cursor) 
when Stopped or when another another Edit Track is 
selected
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Editor - Left-hand side
1. Mount referenced Media 
Files/More options to come

2. Lock Edit Panel/not yet 
implemented

3.3.opens edl list/more 
options to come

4. Select Next Marker, 
+Ctrl select previous 
marker Shift move 
selected Marker to Cursor/
More options to come

5. Normalize Clip or selec-
tion of Clips keeping rela-
tive gain/More options to 
come

6. Adjust Clip Gain with 
fader/More options to come

7. Inactive for now / Enve-
lope not yet implemented 
yet

8. Visible/Invisible track/ 
not yet implemented

9. Track Header/ not yet 
implemented

10. Ctrl modifier as on key-
board

11. Alt modifier as on key-
board

12. Clip & Media grab from 
Libraries and Media Man-
ager / not yet implemented

13. ENTER as on keyboard

14.1deactivated for now / 
Envelope not yet imple-
mented
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Editor - Right-hand side
1. Opens X-Fade Editor / more options 
to come

2. Inactive for now / not yet implemented

3. Inactive for now / not yet implemented

4. Inactive for now / not yet implemented 

5. Solos selected track when jogging 

6. Listen to all when jogging

7. Toggles fine jog mode

8. Zoom with jog wheel / not imple-
mented yet with up-down & left-right 
arrows

9. In & Out point selection of region or 
clip / + Ctrl cuts In & Out to Playhead / 
more options to come

10. Trim In (jog)/ + Ctrl Trim Out / more 
options to come

11. Fade In (jog) / + Shift Fade Out / 
more options to come

12. Up-Down / + Ctrl Move Selection /  
+ Alt Move Clip /more options to come

13. Left-Right / + Ctrl Select Previous-
Next Clip / + Alt Goto Previous-Next 
Edit

14. Shuttle Mode (jog) / + Ctrl Navigate 
Silent (jog)

15. Jog Mode / + Ctrl Loop Jog mode

16. Shift modifier as on keyboard

17. Select Clip Under Cursor / more 
options to come
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Track Selection and User Keys

This is an example of the kind of functionalities and display possibilities that will IN THE NEAR FUTURE  
be available on your edit bay. As of today the top part of the Alphanumeric Display is dedicated to display-
ing Track Names and the bottom part for Edit Track numbers. 

The big buttons select the desired Track on which, for example, you wish to edit a Clip.

The small buttons action is dependent on which Modifier is currently enabled on the Editor; i.e. Mute, 
Solo or Track-arm. It will also be as mentioned above for future implemented user defined functionalities

View and Modifiers

All the buttons in the View and Modifier section of the Editor are functional on a basic level. Once the Edit 
bay functionality is complete the aim is to use a combination of the Jog-wheel, up/down-left/right arrows 
and the small buttons underneath the select buttons under the Alphanumeric screen to help navigate within 
windows such as libraries and the Media Manager. This will also mean that the focus will be given to those 
windows when open.

At present these Modifiers toggle Pyramix Tab Windows Open and Closed.

Note:  the editor button is not functional yet.
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12 Pyramix Mixer

Overview

The Pyramix Mixer has evolved into an extremely powerful tool kit. The extensive range of components and 
the routing and automation possibilities can be a potential source of confusion. However, the basic princi-
ples are simple and logical. Signals enter mixer strips at the bottom, go through various controls and pro-
cessing to the top of the strip where they are routed to a bus or busses. The busses run horizontally and the 
sum of the bus signals enters the bus master strip at the top and moves down through a master fader and 
other controls to the output(s).

Native VS3, VST and External Insert plug-in effects can be inserted in input strips, aux masters and buses. 

If you are new to Pyramix, use one of the simpler mixer templates to familiarize. E.g. Mix 08 X 02 (Stereo)

Mixer Pages

The Mixer user interface is arranged in five pages grouping functions in a logical manner. Most time will be 
spent working in the main Mix ! page. The other pages, Automation, Configure, Route and Organize, 
toggle with the Mix ! screen and are accessed from buttons at top right of the screen...
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Configure Page

In the Configure page multiple changes may be made to the mixer without it rebuilding after each change. 
The rebuild only occurs when you exit the page. 

Settings
Mixer Settings
Opens the Mixer Settings window at the All Settings > Misc > Mixer Settings page.

Show Distribution
When on (lit), a narrow colored bar is inserted at the bottom of each input strip. This indicates which card 
(in a multi-board system) is providing the DSP for the strip.

Mixer Configure Page
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Meter Bridge
When on (lit) the Meter Bridge Window is available to be opened from View > Windows / Tools > Meter 
Bridge or the Toolbar icon. Please see: Meter Bridge  on page 80

Delay Comp Mode
Drop down list menu:

Offers the choice of Full Delay Compensation, All but effects latencies and Off.

Please see: Mixer Delay Compensation  on page 120

Mixer Configuration Summaries
The two panels at bottom right summarize the current mixer configuration. Input Strip Summary  lists the 
total number of Channels and Input Strips and the quantity of each type. Buses / Masters Summary lists 
the total number of bus channels and buses strips with the quantity of each type.

Note: Rebuilding a large mixer with many effects can take some time.

Click and drag the separator bar between Strips and Busses to show more or less busses. The scroll bars 
give access to strips currently off screen.

Direct Outputs
The Direct Out connection is disabled by default. It can be enabled in the Configuration Page by selecting 
the strip and clicking on the DO: Off box or disabled if the box shows DO: On. Alternatively Direct Out can 
be set in the Route Page by clicking on the Strip Header. 

The Direct Out can be routed by Channel to any output of the HDTDM or XDTDM bus. The Direct Out can 
be sent Pre or Post Fader. Click on the DO: Post box in the Mixer I/O section to toggle. The Direct Out is 
currently always Post Effects. For multi-channel strips clicking in the box above the DO:   box pops-up a 
Set Direct Out list:

Highlight the required channel. This will be fed to the logical output assigned in the Mixer Route page or by 
clicking on the DO XLR icon in the Mix page.

Selecting Strips
Strips can be selected by clicking on the label at the top of the strip which turns orange to show it is 
selected. Selection uses the conventional modifier logic: Clicking a second strip while holding SHIFT 
selects all strips in between and strips can be individually added or subtracted from a selection by clicking 

Set Direct Out
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with the Ctrl key held down. Ctrl + A selects all strips. Strips can be selected by type using the Select con-
text menu.

Strip and Bus operations
Once selected, strips can be dragged and dropped to reorganize. Other strip operations make use of the 
Topology and Display menu buttons. Each button pops up a list of options:

Add Strip - Mono, Stereo, MS, GPS and Group pops up a dialog with appropriate options:

Topology and Display menus

Add General Purpose Input Strip(s) dialog
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Add Bus - Mono Mix Stereo Mix Surround Mix and Aux is similar:

Duplicate Strip(s) adds a copy of the selected strip(s) to the right of the selected strip(s) including settings 
(pan, gain etc.) and effects.

Select Offers selection choices to speed up configuration.

All Strips
All Buses
All Mono Strips
All Stereo Strips
All GPS Strips
All Group Strips

Productivity Shortcuts
Ctrl + A selects All Strips, DELete, deletes all selected strips.

Selected Strips can be dragged to a new location in the mixer. The screen scrolls horizontally when you hit 
the edges of the Strip panel.

Double-clicking a Strip toggles it’s collapsed/uncollapsed states.

Strip names can be edited by clicking in the name box and typing. Tab moves to the name box of the next 
strip to the right, SHIFT + Tab moves to the name box of the next Strip on the left.

Add Surround Mix Bus(es) dialog
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Effect Management
Clicking on Effects >> expands the Effects section.

This offers several methods of managing effects on strips and busses.

Configure: Effects Buttons
Add Pops up a sub-menu with options

Add On Selected Strips..
Add On All Strips..
Add On All Buses..

Configure Page -  Effects section
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Each of these three options opens an Add Effect On XXX dialog, identical apart from the title

Note: That the different types of effect are shown by color. Pale Gray for VS3 and Red for 
VST. These colors are also used when effects are shown in containers in the Strips display.

Remove Pops up a sub-menu with options:

Remove Selected Effects..
Remove From Selected Strips..
Remove All From All Strips..
Remove All From All Buses..

Move Up Moves the selected effect(s) up in the list.

Move Down Moves the selected effect(s) down in the list.

Effects Section Containers
The Effects section of each strip is divided into two container areas by plug-in type, VS3 at the top and VST 
below. Clicking on the Click to Add buttons in each container pops-up a list of available plug-ins in the rel-
evant format sub-grouped by type. E.g. Dynamics, Restoration etc. Simply select from the list by clicking on 
an entry to install the plug-in in the Strip. When a Strip or Bus has many effects, the container expands to 
accommodate them.

Shift Order

Add Effects On Selected Strips dialog
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You can change the order of the VS3 and VST containers by clicking on the Shift Order buttons below the 
containers.

Selecting, Copying and Moving Effects
You can select an installed effect with a left-Click then drag and drop to move or Ctrl + drag and drop to 
copy effects of the same type to a Strip or Bus of the same dimensions or change the order of effects within 
the effect type container of the strip. SHIFT + Clicking a second effect with an effect already selected, 
selects all effects between the first and last selected. Ctrl + Click adds to selection.

Right-clicking on an installed plug-in pops-up a context menu, for example:

Insert before (effect clicked on) > drops down a list of effects of the same type that can be inserted before current 
the effect.

Replace (effect clicked on) > drops down a list of effects of the same type that can replace the current effect. 
Double-Clicking an installed effect does the same thing.

Remove (effect clicked on) Uninstalls the current effect from the Strip or Bus

Copy Selected (Effect type) Effects to selected strips As it says. Target strips can be selected before or after select-
ing the effect(s)

Copy Selected (Effect type) to All Strips  As it says.

Remove All (Effect type) Effects Removes all effect of the current type from the Strip.

Remove All Effects Removes all effects of all types from the current Strip.

Copy All Effects to All Strips Copies all the effects installed in the current Strip to all other Strips.

Copy All Effects to Selected Strips  Copies all the effects installed in the current Strip to all selected Strips.

External Effects Inserts
External Inserts are added in the same way as VS3 Effects. Click on Click to Add and choose Other > 
External Insert

Effect context popup
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Organize Page

Here Mixer Presets and Settings can be managed:

Presets
Storing and Recalling Mixer Presets
Mixer Presets can be saved in a user folder or added to the main Mixer Preset list either for the current user 
or all users.

Default Mixer
To Save the current Mixer setup as the default Mixer, select Store Default.

Storing New Mixer Presets
To add a preset to the main list of available Mixer presets I.e. the list which appears when starting a new 
project, Store New… and enter a name for your Mixer Preset. If the Global box is checked then the preset 
will be available for any user logged on the current machine, if not the preset will be available only for the 
user that created the new preset.

Removing Mixer Presets
To remove a preset from the main list, select it and click on Remove Selected. The Remove Preset dialog 
box appears with OK and Cancel options.

Updating Mixer Presets
To update a Preset with the current settings, highlight it in the list and select Update Selected... the Update 
Preset dialog appears asking if you wish to replace the ‘current preset’. Choose OK or Cancel.

Recall Selected State
This option recalls parameters, panning, levels etc. from a saved mixer preset and applies these to the cur-
rent mixer.

Note: This only applies to strips and effects common to both configurations. If the current 
mixer does not have the same plug-ins etc. non-coincident items will be ignored. similarly if 
you recall the state of a 100 strip mixer to a 10 strip mixer the last 90 strips are ignored.

Mixer Organize Page
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Saving / Loading Mixer Presets to / from files
Mixer Presets can also be stored in Windows folders. Select Load from file... or Save to file... as appropri-
ate. A Windows Explorer window opens enabling a previously saved Mixer Preset to be loaded or the cur-
rent Mixer Preset to be named and saved to any Windows folder.

Wizard...
Opens the Configuration Wizard Window 

Route Page

Route brings together all routing to and from physical I/O in an intuitive matrix routing grid environment. It 
opens in the Strips Input page:

Strips Direct Out and Masters Outputs are similar.

Mixer Configure Page
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Making Connections
When the cursor is hovering over a destination crosspoint the column and row are highlighted for ease of 
viewing. If the cursor is over a crosspoint which is part of a multichannel strip or bus the other channels in 
the group are also dimly highlighted. In Strips Inputs clicking on a crosspoint routes the source in the left 
hand column to the destination in the top row. In Strips Direct Out and Masters Outputs sources are hor-
izontal and destinations vertical. Clicking and dragging allow multiple assignments to be made rapidly.

Right-clicking a crosspoint pops-up a context menu with options appropriate to the destination.:

Auto-Connect
Connects all the Strip Input Channels to physical inputs in ascending order.

Disconnect All
Removes all crosspoint assignments.

Info
The Info box shows detail about the currently highlighted crosspoint.

Automate Page
UNDER CONSTRUCTION
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Mix !

Basic Mixer

Expand / Collapse
The small, grey + - boxes on the right of the mixer surface toggle horizontal areas of the mixers surface 
shown full size or collapsed. They also pop-up context menus when the cursor is above them. (see below) 
Expand / Collapse and Hide can reduce clutter by concealing unused controls. This is the same mixer with 
all areas Collapsed:

Stereo Bus
pop-up

Effects
pop-up

Gain
pop-up

Mute
pop-up

I/O
pop-up

Mixer
pop-up

Simple 8 X 2 stereo mixer Window with all areas visible

Automatic Delay Compensation
Indicator / Button

Simple 8 X 2 stereo mixer Window with all areas hidden
 Pyramix Mixer 12 - 104



Ramses MSC reference guide
Pyramix Mixer : Mix !
Each + - box also pops-up a menu relevant to the area of the mixer it deals with when the cursor is above 
it. E.g. : 

Collapse/Hide
Choosing Collapse leaves a small artefact of the mixer area visible, a gray horizontal bar with a + box at 
the right-hand side. Hide completely removes the area from view. Choosing Show All in the Mixer + - pop-
up will restore.

Resets
These context menus also provide a convenient way to restore all controls of specific types or, in the rele-
vant sections, the entire strip or mixer to the default condition.

Bus + - context menus
The precise content of this pop-up depends on the type of bus and whether there are multiple stems: 

Set All to 1st Stem
As it says. All sources will be routed to the first stem of a multiple bus.

Set All ON/Off

Simple 8 X 2 stereo mixer  + -  pop-up menus
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Activates/deactivates the routing to a Bus or Bus Stem for every Input Strip.

Auto-Select
Is exactly the same function as the one provided in the right-click menu over a Multi Mono bus from the 1st 
strip; ie it auto-sets the routing of every strip’s channels to a Multi Channel Bus, so that (as far as possible) 
each Input Strip channel is routed to a Bus channel matching the same grid index (diagonal routing). 

Colors
Bus paths can be colored to aid comprehension.

Hide or Show Colors hides or restores the colored lines. Change color allows the color of an individual 
bus to be altered. Reset color restores the color to its previous state.

Mixer with colored bus paths
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Mixer Components

Input Strips
Mixer Input Strips associated with tracks (the pale green box in the track header) are fed by and control the 
monitor output of the tracks. The Mixer Strip Channel Live (physical) or Internal Return Bus Input goes 
direct to the associated Track. When a strip has no associated track it is fed by and controls the Live (phys-
ical) or Internal Return Bus input assigned to it.

When the strip has an associated track, the track output is automatically switched between input and play-
back output depending on transport mode, the monitoring setting in the track header and the setting of the 
Settings > All Settings > Application > Playback/Record : Auto-monitoring option, European Moni-
toring (all tracks turn to INPUT on stop) or US Monitoring (only Record Ready tracks turn to INPUT 
on stop)

Note: When strip channels have an associated track NONE of the strip controls, fader, 
mute, eq etc. affect the signal fed to the track input. 

Mixer Input Strips have the same functions as the input strips of any standard mixing console providing 
level control, pan, mute, etc.

The following types of input strips are available:

• Mono input Strips

• Stereo input Strips

• MS decoder Strips - decode a Sum and Difference signal to standard stereo format

• GPS (General Purpose Strip)

Mixing/Monitoring/Aux Busses
These are the summing busses where mixer strip signals are routed to. Each bus type (Mix or Aux) has a 
Repro button in the Master section to allow this bus to output signal only when the system is playing back. 
No signal will be output in Stop or Record modes, for example to avoid audio feedback (howl round) in the 
Studio main speakers when Tracks auto switch to input when Recording or Stopped.

Mix Bus
A mix bus is the destination for the final product of your mix. The outputs of a mix bus are usually routed to 
a master machine to record the final mix. They can also be routed via Internal Return Busses. Apart from 
their other uses, these enable the final mix to be recorded in Pyramix. Main Mixing and Aux Busses also 
appear in the Monitor.

Mix Busses are available in several formats:

Mono Mix
Provides a single mono output. Any input strip can be routed to it.

Multiple Mono Mix 
Provides several mono outputs. Any input strip can be routed to any or all of them

Stereo Mix
Provides a single stereo output. Any input strip can be routed to it

Multiple Stereo Mix
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Provides several stereo outputs and allows any input strip to be routed to any or all of them

Surround Mix - 5.1 format
Multiple Surround Mix - provides several surround outputs and allows to route any mixer strip onto any of 
them.

Note: Unlike mono and stereo multiple busses, input strips can only be routed to ONE 5.1 
destination stem of a multiple surround bus. This reflects their normal use. E.g. a common 
set-up will have three surround bus stems for Dialogue, Effects and Music. Each Input strip 
is routed to the appropriate surround bus by clicking on the Stem ‘X’ button.
All surround bus stems can be summed for monitoring in the Monitor.

Multiple Mix Busses
Mono / Stereo
When a mono or stereo multiple mix bus is added to the mixer a routing matrix box appears in the input 
strips with a send level control (mono) or pan control (stereo).

The 8 by 8 matrix gives access to up to 64 output busses. Routing is shown by lit crosspoints.

Double-clicking the matrix in the strip opens the routing matrix window.

Valid choices are shown in gray. Once the window is open, other input channels can be route by either 
selecting them from the drop-down list or using the < and > arrows to step across the mixer surface.

Mix bus matrix

Mix bus routing matrix
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Surround
Up to 16 surround busses each with from six to nine channels may be added as a single Multiple Sur-
round Mix output strip. The principle use of these is for stem mixing where, for example, dialog, back-
ground effects, spot effects, foley and music are recorded as separate recordings but monitored as a 
complete mix. Each surround bus is identified by number. In this illustration, a Multiple Surround Mix strip 
has been added to the mixer with three surround busses.

Clicking on the label above the Surround Panner pops up a list of the available stems. Simultaneously 
selecting more than one on a strip is not possible.

The associated Surround Mix output strip routing is shown below:

The top (SR1) box shows what the meters are displaying. Clicking on it cycles through each Stem and Lvl: 
All which meters the sum of all the Stems The bottom box shows and selects which Stem the XLR icons 
refer to. Routing to physical outputs or Internal Return Busses is accomplished in the same way as other 
busses. I.e. right-click the relevant XLR icon and select Connect > etc. from the menu. 

Multiple Surround Mix Output Routing
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Groups
Master Group Strips - allow the grouping of faders of several mixer strips. Analogous to VCA grouping. 
When a group or groups are added (from the mixer contextual menu Settings > Add Strip > Group) A 
group button for each group created will appear below the strip name box on each input strip. When 
selected, the associated Group strip will control the grouped input strips if the On button is lit on the Group 
strip.

Channel Direct Outputs
All input strips can have Direct Outputs. The Direct Out connection is disabled by default. It can be 
enabled in the Configuration Page by selecting the strip and clicking on the DO: Off box or disabled if the 
box shows DO: On. Alternatively Direct Out can be set in the Route Page by clicking on the Strip Header. 

The Direct Out can be routed by Channel to any output of the HDTDM or XDTDM bus. The Direct Out can 
be sent Pre or Post Fader. Click on the DO: Post box in the Mixer I/O section to toggle. The Direct Out is 
currently always Post Effects. For multi-channel strips clicking in the box above the DO:   box pops-up a 
Set Direct Out list:

Highlight the required channel. This will be fed to the logical output assigned in the Mixer Route page or by 
clicking on the DO XLR icon in the Mix page.

Although there can be any number of Input Strips and Busses from 1 to 64 in HDTDM or 1 to 128 in 
XDTDM, there is a limitation on the number of Direct Out connections: The sum of the Direct Out connec-
tions PLUS all Busses channels can not exceed 64 in HDTDM or 128 in XDTDM.

Strip & Bus Channel Types
 All Strips and Busses Channels have a custom type that can be manually set in the Configuration Page 
to:

• Left (L)

• Center (C)

• Right (R)

• Surround Left (Ls)

• Surround Right (Rs)

• LFE (Lfe)

• Left Center (Lc)

• Right Center (Rc)

• Surround Center (Cs)

• No particular type

Mono Strips are tagged by default to no particular type

Set Direct Out
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Stereo Strips are tagged by default to L-R

MS strips are tagged by default to C-W

GPS Strip (General Purpose Strip):

GPS Strips can have from 1 to 8 channels

They can be used as Aux returns or for any kind of direct Input usage e.g. premixes or multi-channel 
recordings.(LCR, LCRS, etc…) By default a 2 channel GPS Strip is initialized to L-R and a 6 channel GPS 
Strip is initialized to LCRLsRsLfe 5.1. This can be changed/customized in the Configuration Page.

GPS Strips feeding any busses (Aux or Mix) are routed by default by Channel Type (like any other strip) but 
this routing can be manually changed by clicking on the Channel Routing grid (like any other strip).

Aux Busses:
General Purpose Aux busses provide a way to create ‘auxiliary’ mixes which are normally used to provide 
headphone or cue mixes for musicians, or to send signals to effects such as reverbs, delays, choruses, etc.

Aux Busses can have from 1 to 8 channels. Channels have a custom type that can be manually set in the 
Configuration Page to:

• Left (L)

• Center (C)

• Right (R)

• Surround Left (Ls)

• Surround Right (Rs)

• LFE (Lfe)

• Left Center (Lc)

• Right Center (Rc)

• Surround Center (Cs)

 By Default a 2 channel Aux Bus is initialized to L-R and a 6 channel Aux Bus is initialized to 5.1. This can 
be changed/customized in the Configuration Page.

Note: When an Aux bus is added it is important to ensure that the Type for each channel of 
the Aux bus is set correctly.  
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Context Menu
As with other buses, Clicking on an Aux bus’s small gray  box on the right-hand edge of the mixer win-
dow Expands / Collapses the send display. When the cursor is above the box the Aux Bus pop-up context 
menu opens:

Most of the entries are the same as other buses, but the last two entries are specific to Aux buses.

Global Strip Channel Routing
Opens the Global Channel Routing window for the Aux bus 

This routing grid groups together the Channel Types of all the input Strips present in the current mixer, 
shown horizontally (L, R, C, ...). The vertical channels are the Channel Types of this Aux bus. When a 
node’s value is edited, the static aux send gain of all strips having this channel type is updated with the new 
value for this aux bus. When some strips are already set to different values for a specific node “---” is dis-
played.

Clear Sets the entire grid to Mute
Unity Sets the entire grid to Mute

Note: Invoking either Clear or Unity will affect all Strips Aux Sends to this Aux Bus.

Apply All Strip Input Gains to Send Gain
The current input gain value of every strip in the mixer will be applied to all the Aux sends feeding this Aux 
bus. 

Aux bus pop-up context menu

Global Channel Routing window
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Aux Send Routing
When a Strip feeding an Aux Bus is of the same type as the Aux bus E.g. Stereo strip feeding stereo Aux 
bus 5.1, Strip feeding a 5.1 Bus the sending Strip’s Channels are automatically routed to the corresponding 
Aux bus Channel Type. (Left to Left, Right to Right, etc…).

Where the sending Strip differs in Type to the Aux Bus E.g. a Stereo Strip feeding a 5.1 Aux Bus, the rout-
ing must be made manually. The same method is used if you wish to alter auto-routed values.

Static Channel Routing
Aux Send Channel Routing is set by clicking on the little grid icon adjacent to the knob on the Aux Bus send 
in the channel strip. This opens a Channel Routing window:

Shown here with a 5.1 channel feeding a 5.1 Aux Bus. Gain values can be entered for each node of the 
Strip/Bus crossing. Just click on any node and enter a dB value. Enter nothing (no character) or -144.5 to 
reset the node to Mute.

Clear Clears all nodes to Mute
Auto Sets a 1 : 1  flat routing as shown above

Channel Routing window
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Aux Buses In-Place Panning
In-Place panning for each Aux bus is turned on with the IP button in Aux Send section(s) of each Input 
Strip. In-Place Aux Sends take the ouput(s) of the appropriate panner at the same level(s) the panner is 
feeding its output bus.

Note: Only corresponding Bus Types are fed in this way. Thus if you feed a Mono Aux Bus 
typed Center from a 5.1 panner and there is no signal on the centre channel no signal will 
be fed to the Aux Bus even if the signal on the left and right outputs is identical creating a 
‘phantom center’.

In-Place Panning Source
When an IP button is lit (yellow) on an Input Strip, the way in which the aux send channels are routed to an 
Aux bus is determined in the Aux return strip. For example, in a mixer configuration with an Aux bus, a Sur-
round bus and a Stereo bus. Clicking on the highlighted box below the Aux master fader pops up a list of 
options:

These determine whether the Aux send will follow one of the output bus panners or the Static Channel 
Assignment set in the Input Strip. E.g. for Aux bus 1:

In-Place  Panning Indicator/Selector

In-Place Panning Source pop-up
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Off (Use Channel Routing Grid) Aux pan follows Static Channel Routing assignment
SR1 (Surround Mix) Aux pan follows Surround Mix bus panners
ST1 (Stereo Mix) Aux pan follows Stereo Mix bus panners
To make all the Aux 1 sends follow the Mixer Strip Surround Panners, click on the box below the fader and 
select SR1 (Surround Mix)

Note: When IP:Off is displayed in the Aux master strip I.e. no In-Place source is selected, 
then the IP buttons in the input strips will be grayed out. Similarly, when an In-Place source 
IS selected and the yellow IP button in the input strip is lit then the static routing grid is 
grayed out and unavailable as in this illustration.

The three strips shown are 10, 11, and 12. Since the IP button is selected (Yellow) on strips 10 and 11 the 
static routing grid is grayed out and thus unavailable. On strip 12 the IP button is deselected (dark) and the 
Static Channel Routing grid can be opened by clicking on the grid button next to the knob.

Note: The IP button defaults to On when the aux send is first turned on. If the send is sub-
sequently turned Off (muted) then the current setting of the IP button is remembered when 
it is unmuted.

Strip Aux sends and Channel Routing dialog
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Basic Strip
A basic mono channel strip contains:

On /Off toggle switch

Pan pot to Main output bus. In this case there is just a single stereo mix bus.

Numeric display of fader output level value, if cursor is over a fader knob shows 
fader gain. If cursor is over pan-pot, shows current pan position. May be clicked to 
directly enter a fader gain value.

Level Bargraph Rotary Controls and Faders
Rotary Controls and Faders may be adjusted by grabbing them with the mouse and 
dragging. Rotary controls are adjusted by dragging left or right and faders by drag-
ging up or down. Double-clicking a Fader or Rotary knob returns the value to the 
default. E.g. unity gain on a channel strip fader. Bargraph shows peak level

Buttons
Buttons on the main mixer surface are black when inactive. When active they ‘light 
up’.

Solo solos the strip, Mute mutes the strip Ctrl + Solo cancels all other Solos

SAFE prevents the strip being muted by solo operations elsewhere. Ø reverses the 
channel phase. PF changes the metering position to Pre-Fader.

Delay A delay value (in samples) can be set in this box.

Input Clicking on Input pops-up a box with the choice of the strip taking its input 
from a physical connection or any output bus.

Logical Input and Direct Output Assignment
Right-click on the XLR icons to pop-up a drop down list of valid assignments.

Note: Direct Outputs must first be enabled in the Configure page. Please see: Channel 
Direct Outputs  on page 110

Stereo Strips
In a Stereo Strip feeding a stereo bus the pan pot is replaced by a balance control and the single bargraph 
meter is replaced by a pair.

Stereo Strips can reverse the Phase of both the Left and Right channels. The single button has four possi-
ble states:

 Black: No phase inversion
 White: Left channel inverted
 Red: Right channel inverted
 Blue: Both channels inverted

Basic Strip
 Pyramix Mixer 12 - 116



Ramses MSC reference guide
Pyramix Mixer : Creating and Configuring Mixers
M&S Stereo Strips
What is M&S?
M&S stands for Middle and Side. M&S is a microphone technique which outputs Sum 
and Difference signals instead of Left and Right (also known as LR, AB  or XY). These 
Sum and Difference signals are often known as M&S although this nomenclature is often 
a source of confusion... 

Sum and Difference signals can be created from a conventional Left, Right source. For 
example, by using the Pyramix MS Encoder plug-in.

Decoding M&S
A Sum and Difference or M&S decoder reconstitutes Left and Right by adding the Differ-
ence (S)  signal to the Sum (M) signal to produce Left and adding the phase-reversed 
Difference (S)  signal to the Sum (M) signal to produce Right. This is often represented 
as:

L = M + S and R = M - S

Benefit of M&S
In mixing as opposed to recording, the main practical benefit of manipulating a signal in 
the Sum and Difference domain is true control over the width of the image. Pyramix can 
handle these signals directly thanks to the provision of M&S Stereo strips.

M&S Strip controls
An M&S strip stereo bus send has three controls. The center knob determines the Sum 
(M) contribution to the Left and Right outputs. The  L knob determines the in-phase Differ-
ence (S)  contribution to the Left output and the R knob determines the out-of-phase Dif-
ference (S) contribution to the Right output. The L&R knobs are ganged by default. To 
move them independently click and drag with the Ctrl key held down.

The Phase of both the Sum and Difference channels can be reversed. The single Ø button has four possi-
ble states:

 Black: No phase inversion
 White: Sum (M) channel inverted
 Red: Difference (S) channel inverted
 Blue: Both channels inverted
Inverting either Sum or Difference results in the image being reversed left to right.

Note: If the Input meters consistently show S  higher than M then either the image is very 
wide and unlikely to be compatible for a mono listener or the M and S inputs have become 
reversed at some point. Regrettably, this is extremely common when dealing with location 
recordings in film and TV.

Creating and Configuring Mixers

If one of the numerous mixer presets does not quite suit your application it is simple to modify an existing 
mixer, create one using the Mixer Wizard or design one from scratch. The Wizard can be started from an 
existing mixer by right-clicking anywhere on the mixer surface and selecting Settings > Wizard...
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 Mixer Configuration Wizard

Select the type(s) of busses required using the check boxes and the number needed from the 
drop down lists on the right. Note that a single Mono or Stereo Mix Bus can consist of from 1 
- 64 busses, and a Surround Mix Bus can consist of from 1 - 16 multi-channel stems.Aux 
Busses can have from 1 - 8 channels. Click the Next button to move on to the next page.

Select the type(s) of channel strips required using the check boxes and the number needed 
from the drop down lists on the right. Click the Next button to move on to the next page.

Configuration Wizard buses dialog

Configuration Wizard strips dialog
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Checking the Connect automatically as many inputs and outputs as possible check-box 
will create the same number and types of Tracks as there are Input Strips and connect as 
many as possible to the available physical inputs in ascending order and output Busses to the 
physical I/O attached to the Mykerinos board(s) and Track outputs to Mixer Input Strips, 
although you can easily reconfigure this later. If the box is not ticked, the tracks will be created 
in the same way with Track outputs connected to Mixer strips but no physical Inputs or Outputs 
will be connected.

Clicking Cancel opens the new Project with a Blank Mixer Window (See below)

I/O Busses Explained
The total number of available output busses, regardless of the number of Mykerinos cards, is 64 in HDTDM 
Mode and 128 in XDTDM Mode. The maximum number of logical inputs and outputs to Pyramix is also 64 
and 128 respectively. However, it is perfectly possible, and permissible, to have more than 128 physical 
inputs and outputs connected to a Pyramix system. Routing to assign physical inputs and outputs to Pyra-
mix logical inputs and outputs is made in the Settings > Hardware > HDTDM Routing or XDTDM pages. 
For example: a system containing three Mykerinos boards, with MADI daughterboards has a total of 192. In 
HDTDM mode any 128 of these may be routed to Pyramix logical inputs and any 128 Pyramix logical out-
puts (less the number of assigned Internal Return Busses; see below), can be routed to physical outputs.

Input Strip Types
To make is easier to work with a variety of source Formats Pyramix offers a number of different types of 
Input Strip. These can control from one to 8 channels from a single set of controls.

Internal Return Busses
Some of the time slots on the HDTDM/XDTDM bus can be reserved to convey Aux or Master Output Bus-
ses back to input strips. In effect, these are internal send/return paths. To change the number of available 
Internal Return Busses, close all open Projects (if any) and go to:

Settings > All Settings > HDTDM Routing or HSR-HTDM if using HTDM mode. 

Configuration Wizard auto connect dialog
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XDTDM Routing > PCM I/O routing or PCM-HSR I/O Routing if using XDTDM mode. 

DXD Projects I/O Routing if you wish to use Internal Return Busses in a DXD Project. 

The number of Internal Return Busses can be set using the Internal Busses combo box. Click on the OK 
button to memorize the setting and exit.

The number of Internal Return Busses you assign here will be available as possible channel strip sources 
in the mixer.

Mixer Delay Compensation

Summary
Mixer Delay Compensation offers a choice between:

Full Delay Compensation (including effects)

All but effects latencies

Off

This choice is made in the All Settings > Project > Mixer > Mixer Settings page along with a switch to 
turn Automatic Compensation on or off and a slider to set the Maximum Mixer Delay Compensation. 

Delay Compensation Switching
As detailed above, Compensation can be selected in the All Settings menu. It can also be toggled On/Off 
in the Mixer context menu. Right click and select Settings then click on Enable Delay Compensation to 
toggle On or Off. 

Note: The Full Delay Compensation / All but effects latencies setting is retained when 
Compensation is switched on and off from the mixer window.

With Mixer Delay Compensation turned On and All but effects latencies selected:

1. Input strip set as a (normal) Input: no compensation. If a Delay is applied manually the output signal of 
this strip will be delayed by the applied value.

2. Input strip used as an Aux or Bus return, i.e. patched to an Internal Bus and set as an Aux or bus return 
(see Input Strip Mode  on page 122): all other Output Strips are automatically delayed by the amount 
equal to the Bus internal processing delay.

3. Input strip used as an External Aux or Bus return, i.e. where the Aux or bus signal is sent outside the 
workstation and returned to a physical Input:  All other Strips are automatically delayed by the amount 
equal to the Bus internal processing delay providing the Input is set as an Aux or Bus (see Input Strip 
Mode  on page 122). If a Delay is applied manually, for example to compensate for the delay in an 
external processor, the signal of all other output strips will be further delayed, according to the value 
entered.

When Full Delay Compensation is selected, Plug-in effects that correctly report their latency will also 
have their delay compensated. Further, this delay will be maintained when the plug-in is in bypass mode.

Please see also:See “Delay Compensation Policy” on page 154.
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Delay Compensation

Delay Compensation Indicator
A small button labeled D adjacent to the Organize button indicates the current state of delay compensation 
in the mixer:

A stable green indicates that delays are compensated.

Stable red indicates that delays are not compensated.

Blinking red indicates that you need to adjust the maximum length of delay that can be compensated in 
order to achieve proper compensation.

Maximum Delay Compensation
Pyramix sets a default value for the maximum number of samples of delay that can be compensated auto-
matically. As effects are added the required total delay value is calculated. If an Effect is instantiated that 
will exceed this limit the Mixer error: Delay compensation dialog appears:

To deal with the problem either remove an effect or effects or go to Settings > All Settings > Project > 
Mixer > Mixer Settings and increase the Max Mixer delay Compensation - Delay  setting to a value 
slightly in excess of that proposed in the dialog.

Note: Increasing the Delay value too much steals valuable memory from MassCore.

Outboard Latency
Typical latency in ms of outboard gear ranges from 2 to 5 ms. The following chart may help you to compute 
the proper delay compensation values for outboard equipment:
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Delay Chart

Time Alignment of Recorded Clips
All recordings from Input Strips designated as Input are automatically time-aligned. E.g. recordings from 
live inputs.

Recording Bus Returns
When recording the output of an input strip taking an Aux or Bus return, for example to “freeze” a reverb 
track, the recorded media will be placed too early in the Timeline. In this situation it may therefore be desir-
able to designate this Aux or Bus return as a normal Input in order to ensure correct time-alignment of the 
recorded clip.

Note: For Power Users the SABR debug windows show the delay values applied to each 
bus / aux node and may prove useful.

Delay Compensation Detail
All digital processing takes a finite amount of time. When Internal Return Busses are used to route Aux or 
Master output busses back into channel inputs (by selecting an Internal Return Bus input from the routing 
pop-up for the Aux or Bus output, and selecting an Internal Return Bus output as the return channel 
input) all other busses not so routed must be delayed if the Mixer is to be ‘time-aligned’ I.e. If a signal is fed 
to two inputs, the first feeding the Main Output direct and the second routed back to an input via (say) an 
Aux bus with the return input strip routed to the Main Output, then the second will be delayed with respect 
to the first. Selecting Settings > Enable Delay Compensation from the mixer context pop-up menu will 
automatically ensure both signals remain in sync by delaying the signals directly routed to the Main Output 
by an amount equivalent to the delay introduced by the extra processing in the second path.

Input Strip Mode
In order for Pyramix to correctly calculate the required delay you have to tell it which bus is the source for 
the Internal Return Bus. Clicking on Input at the bottom of the strip, above the XLR icon, pops-up a list of 

Ms samples@
44.1kHz

samples@
48kHz

samples@
88.2kHz

samples@
96kHz

samples@
176.4kHz

samples@
192kHz

samples@
352.8kHz

1 44 48 88 96 176 192 352

3 132 144 265 288 529 576 1058

5 221 240 441 480 882 960 1764

7 309 336 617 672 1235 1344 2470

9 397 432 794 864 1588 1728 3175

10 441 480 880 960 1764 1920 3528

12 529 576 1058 1152 2117 2304 4234

Max Delay 
(Auto 
PLUS 

Manual)

1216 1216 2432 2432 4864 4864 9728
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all the output busses and Input. Input is the default and means the strip is fed from a physical live input 
and no delay compensation is required. If any Internal or External Return Bus is ticked and Automatic 
Delay Compensation is turned on, Pyramix calculates the required delay and applies it to all Output buses 
not feeding a return bus.

Delay vs. Delay Compensation
When the Input Strip Mode is set to Input the delay setting affects the only the delay on the strip’s signal. 
When {any Bus name} Return is selected as the Input Strip Mode the delay setting affects the delay on all 
other output bus signals to ensure correct time-alignment.

Delay Compensation of External Inputs
Where an Output Bus or Aux Bus is used to feed an external processor via a physical output and the exter-
nal processor output is fed back into Pyramix via an external live input, then the necessary delay compen-
sation must be computed and applied by the operator since Pyramix has no means of determining the 
delay of the external device. However, the Input Strip Mode (Click on Input to pop-up the menu) should be 
set to the bus feeding the external processor (as above) so that the input channel delay setting affects 
delay compensation rather than simply delaying the signal through the input strip.

In the illustration, Aux Bus Ext Rev feeds an external device via physical outputs 17 & 18. The outputs of 
the external device are connected to physical inputs 7 & 8. The channels’ Mode has been set to Ext. FX 
Return and delay compensation of 256 samples applied. 

In contrast Int FX  output bus feeds Internal Return Busses 1 & 2 (IB1 & IB2). Two channels are fed by 
the IB1 & IB2 outputs with their mode set to Int FX Return.

External Insert Plug-ins
Internal VS3 Engine latency is automatically compensated except for the daughter card I/O latency (for 
example a Send/Return on AES/EBU takes 6 samples). Thus you have to manually set the delay of the 
external unit plus the I/O latency. It is not possible to change the delay or change the bypass status during 
playback or recording.

Determining Delay Compensation for External Effects Loops
One strategy for achieving this is to route a signal directly to an output bus and, via an Aux, to a physical 
output, to the external processor’s input. The processors output is connected to a physical Pyramix input 
and routed to an input strip. The strip mode must be set to the bus used as the source. Then use impulse 
sounds, clicks, rimshots etc. to aid manual adjustment of the delay compensation.

Determining Delay Compensation for External Insert Plug-ins
A similar strategy can be employed here. Route the signal you wish to treat via an External Insert Plug-in to 
two input strips. Add the External Insert in one strip only complete with the external processor in circuit. 
Delay the untreated strip until the audio is in sync with the treated audio and note the delay value. Then 
apply this value in the Ext. Unit Delay field in the External Insert window.

Input Type pop-up
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Effects Delay Indication
When the mouse cursor is hovered over a plug-in in a strip the required delay value is displayed:

Here you can see that Angudion II currently requires a 448 sample delay to be applied to the other output 
buses. This will be applied automatically when Full Delay Compensation is switched on. 

Configuring a Blank or Existing Mixer

Configuration of the mixer control surface is accomplished via the Configure Page, Route Page (Please 
see: Configure Page  on page 94 and See “Route Page” on page 102.) or contextual menus. The pre-
cise options available will depend on where you click on the mixer. If you wish to affect the entire mixer, 
right-click on the top bar of the Mixer window. To change options for a Bus, right-click on a blank area of the 
Bus strip. Similarly, for a channel input strip, right click on a blank area of the Strip. Right-clicking within a 
function block adds menu entries to the top of the list, relevant to the specific block.

Adding Strips
Right-click anywhere on the Faders, choose Strip > Add and select the appropriate type of strip to add or 
right-click anywhere on the Faders, choose Bus > Add and select the appropriate type of bus to add.

Removing Strips
To remove a given input strip, bus or group, right-click directly on it and choose Strip > Remove (Strip, 
Bus or Group) as appropriate.

Mixer I/O Assignments

To or from physical I/O
To change I/O assignments to or from physical I/O or the Internal Return Busses, click on the appropriate 
XLR icon. Choose Connect Input or Connect Output from the pop-up menu and choose the desired con-
nection.

When connecting a multichannel strip clicking on the header (ADAT(#11290) Optical B in the above illustra-
tion) will connect all channels consecutively. 

Plug-in Name and Delay pop-up

I/O assignment pop-up
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From tracks
Note that several tracks may be routed to the same mixer input strip. Tracks are assigned to mixer input 
strips either automatically or manually from the Track Header.

Plug-ins

Mixer Strip Controls
When Native VS3 Plug-ins, VST Plug-ins and External Inserts  are instantiated in mixer strips each 
instance has a block of one or two buttons. The full Plug-in name or External Insert pops-up along with the 
required delay compensation when you hover the mouse pointer over each block: 

Buttons
Each block has one or two buttons. The left-hand, yellow button is lit when the effect or insert is switched 
on. Switching an effect or insert off removes it from the signal chain and this may well be audible.The right-
hand, red button indicates that the effect is bypassed when lit. Bypassing an effect retains the same delay 
as when the effect is active. Further, well behaved effects will continue to calculate internal parameters 
when bypassed making seamless switching possible.

When Full Delay Compensation is selected, Plug-in effects that correctly report their latency will have 
their delay compensated. This delay is maintained when the plug-in is in bypass mode.

Please see also Mixer Delay Compensation  on page 120

Native VS3 Plug-ins
These include the eq and dynamics found on a conventional hardware mixer’s channel strip. To add a 
native plug-in when in Mix ! mode, right-click with the mouse cursor over the strip where the plug-in is to be 
added. If you right-clicked in the effects area of the strip select Effects > Add. If you clicked somewhere 
else, select Add Effect. Select an effect from the sub-menu. It will appear in the strip.

VST Plug-ins
To add a VS3 plug-in the procedure is the same except select VST Plug-In or Add VST Plug-In.

Note: VST Plug-ins can be added at any time, even during playback, without rebuilding the 
mixer.

Mixer Strip Plug-in Controls with Name and  Delay pop-up
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External Insert
To add an External Insert simply right-click over the strip where the plug-in is to be added and choose: VS3 
Effects > Add > Other > External Insert

Clicking on the External Input name in the strip opens the External Insert Control Window.

Send and Return Connections can be made by clicking on the XLR icons and levels set with the knobs. 
When you have determined the delay introduced by the I/O loop including the external effect the value in 
samples should be entered in the Ext. Unit Delay field. 

Further Mixer Configuration Options

Mixer Context Pop-up menu
The entries on this menu vary according to where you right-click on the mixer surface. At the top of the 
menu the entries concern the specific mixer component under the mouse cursor when you right click. The 
next section of the menu has entries which affect the Strip. Entries from Mixer to the end of the menu affect 
the entire mixer and are available wherever the mouse is right-clicked.

Mixer > Show

Show All Makes all input strips and busses visible

Mixer Strip External Insert Plug-in Control  Window
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Show / Hide > Selects Strips and Busses to be shown or hidden. When checked, the Bus-
ses or strips are visible on the console surface. Both Show and Hide access 
the same lists.

Minimize When checked, Mixer window is minimized
Automation >

Isolate These menu choices toggle the Automation mode for the entire 
Play mixer.
Record
Auto-write

Memory > The choices here enable mixer presets to be saved loaded and managed.

Please see: Mixer Presets  on page 129

Settings >

General... Opens the Mixer Settings window at the All Settings > Hardware > Hardware 
> Formats & Sync page.

Enable Delay Compensation Enables Delay Compensation for the mixer
Dithering Opens the Dithering window. 
Remove Select All Strips, All Busses or All to remove groups of mixer components or 

every component.
Auto-connect Automatically connects the Mixer inputs and outputs using the available inputs 

and outputs of the installed daughter card (s) and the Mixers Preferred Monitoring 
Outputs

Wizard... Launches the Configuration Wizard. Please see: Mixer Configuration 
Wizard  on page 118

Show VS3 Plug-Ins Info Pops up the VS3 Plug-Ins Information window. 

Show Distribution When checked, a narrow colored bar is inserted at the bottom of each input strip 
which indicates which card (in a multi-board system) is providing the DSP for the 
strip.

Mixer Show / Hide pop-up
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Dithering Options

To open the ReDithering window, right-click anywhere on the mixer surface and select Settings > Dither-
ing... The Dithering window opens.

Selected Bus : 
The combo box allows the choice of any of the Mixer’s busses.

Dither Type
The Pyramix Mixer offers a choice of dither algorithms. MT-r and POW-r click the box to choose.

Word Length
The output word length of the digital audio data can be varied from 8 bits to 24 bits. Click on the rotary knob 
and drag left and right to adjust the value.

MT-r
PDF (Probability Density Function)
In basic terms, the addition of a dither signal (noise) into the digital audio streams improves linearity in the 
reproduction of low-level signals. In other words, as signal level drops (such as in a fade out) dithering 
helps to maintain a smooth decay. There are three options:

None
No dither signal will be added to the data.

Rectangular
A rectangle shape dither signal will be added to the data.

Triangular
A triangle shape dither signal will be added to the data.

Dithering MT-r floating Window
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Noise Shaping
Noise shaping is a technique that is used to push quantization noise energy, which in linear digital systems 
is normally spread over the whole audio spectrum (0 Hz up to half the sampling frequency), into higher fre-
quencies where the human ear is less sensitive to its effects. There are three noise shaping options and the 
graph shows the curve applied:

Off 
No noise shaping added.

Hi Pass

This provides a first-order high-pass filter for the noise transfer function. This type of noise shaping takes lit-
tle computational power to produce, but at the expense of not tracking the characteristics of the human ear 
very accurately compared to:

Acoustic
Psycho acoustically noise shaped dither inserts an FIR-filter in the feedback path. This shapes the noise as 
closely as possible to the characteristics of the human ear. More taps in this type of filter allow a closer 
approximation to the response curve of the ear, but each tap, of course, increases the computational 
instructions required. The filter implemented here is a 9-tap FIR-filter, which closely approximates the curve 
of the human ear.

POW-r
POW-r offers the choice of three settings, POW-r 1, POW-r 2 and POW-r 3. The graph indicates the effect 
of the noise-shaping.

Mixer Presets

Mixer Presets can be saved in a user folder or added to the main Mixer Preset list either for the current 
user or all users.

Dithering POW-r floating Window
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Default Mixer
To Save the current Mixer setup as the default Mixer, right click on the Mixing Console and select Memory 
> Presets > Store > Default.

Storing New Mixer Presets
To add a preset to the main list of available Mixer presets I.e. the list which appears when starting a new 
project, right click on the Mixing Console, select Memory > Presets > Store > New… and enter a name for 
your Mixer Preset. If the Global check box is checked then the preset will be available for any user logged 
on the current machine, if not the preset will be available only for the user that created the new preset.

Removing Mixer Presets
To remove a preset from the main list, right-click on the Mixing Console, select Memory > Presets > 
Remove > (preset you wish to remove). The Remove Preset dialog box appears with OK and Cancel 
options.

Saving / Loading Mixer Presets
Mixer Presets can also be stored in Windows folders. Right-click on the Mixing Console, select Memory > 
Save. A Windows Explorer window opens enabling the current Mixer Preset to be named and saved to any 
Windows folder. Similarly, selecting Memory > Load enables a Mixer Preset to be loaded from any Win-
dows folder.

Mixer Surround Components

When a Surround Bus is added to the mixer an surround panner appears at the top on the Input Strips

Speaker Controls
Double-clicking on any of the Speaker Controls toggles the mute on/off of the selected surround channel 
(also muting any audio routed to that surround channel output). When a channel control is muted, it is no 
longer displayed on the Mixer Input Strip.

Joystick Panner
Determines the position of the source within the surround sound space. To position it, simply left-click on 
the control and move it to the desired location. Double-clicking on this control will automatically center it.

LFE Level
Determines the level sent to the LFE (.1) output.

LFE Level

Joystick Panner

Surround Stem Select

Open Surround Control

Front Speaker controls

Rear Speaker controls

Strip Surround  controls
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Surround Stem select
If a Multiple Surround Bus has been added to the mixer Stem ‘X’ appears at the top of the strip. Click on 
the box to select the stem you wish to route the strip to.

Stereo Input Strips.

The Surround Sound Panner Position control behaves slightly differently in a Stereo Input Strip. Notice 
there are now two independent position controls and two independent LFE sends. One for each input chan-
nel.

Open Surround Control
The Surround Control window offers far more information and a greater degree of control over all the sur-
round panning parameters than could be shown on an individual Input strip. It can be opened and closed by 
clicking on the appropriate area on the strip, from View > Windows / Tools > Surround Panner or the icon 
in the View Toolbar when an input strip with a Surround Panner is selected.

Surround Control window

Options available will depend on whether the Mixer Channel is single source (mono) or 2 sources (stereo)

Stereo strip surround controls

Surround Control floating Window
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.Position/Speaker Control
When a single source is used, the Position Control is displayed as a green dot on a grid with 5 speaker 
icons. Each speaker icon represents a Surround Speaker Position (L, C, R, SL, SR). The position of the 
Green Dot determines the position of the source within the surround sound space. To position it, simply left-
click anywhere within the surround sound space. To position it, simply left-click on the control and move it to 
the desired location or use the knobs. Double-clicking on the Green Dot automatically centers it.

Surround Panning Algorithm
The drop down list gives a choice of panning algorithms.

Constant Gain
Allows the surround panning to preserve a constant gain sum on all speakers wherever the Position Control 
is placed.

Constant Power
Allows the surround panning to preserve a constant power sum on all speakers wherever the Position Con-
trol is placed.

Level Meter
Toggles the main display between the Surround Meter and Level Meter. This shows the send Levels to 
each surround channel in the middle of the right-hand section and Output meters on the right: 

Surround Control floating Window
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Stereo Surround Control

Surround Meter
The Display can show static Left, Right and Summed Lobes in white, red and yellow, respectively when the 
buttons are lit with the actual signal in bright red.

Link
Click and drag on the red and white balls is independent and the controls are switched between Source 1 
and Source 2 by clicking on the buttons. If a Link option is chosen from the combo box click and drag and 
the controls will affect both sources depending on the chosen linking.

Surround Control floating Window

Surround Control Link combo box
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Strip and Bus Tools
In a multi-channel strip the clicking the show/hide Routing button displays the channel routing buttons. 
There are as many routing buttons as there are channels in the strip. Strip and Bus Tools affect all channels 
whose routing buttons are lit blue. In Mono and Stereo strips the routing buttons are on by default. In GPS 
strips only channels 1 & 2 have their routing buttons on by default. 

If more than one instance of Strip or Bus Tools is used in the strip this allows, for example, different settings 
to be applied to Front L-R and Rear L-R.

Show/Hide Routing

Routing Buttons
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13 Strip and Bus Tools

Strip and Bus Tools

Eq, Comp/Limiter/Expander
Strip and Bus Tools are a quick and efficient way of adding the Equalization and Dynamics (compression 
and expansion) functions commonly found on hardware consoles to channels and busses. Strip and Bus 
Tools are particularly economical with DSP processing power. Each processing block may be switched ’into 
circuit’ individually. Blocks which are not ‘in circuit’ do not use DSP resources.

Difference between Strip Tools and Bus Tools
There is only one difference between Strip and Bus Tools. Bus Tools have a sophisticated Limiter with 
Look-ahead and Delay Compensation where Strip Tools has a Compressor.

Both may be freely used in Strips or Busses if the need should arise for a limiter in an Input Strip or a Com-
pressor in a Bus.

Modules
The Strip and Bus Tools plug-ins consist of several Sections or modules. Each Section has a title bar at 
the top containing an On/Off switch for the section and a control triangle which toggles between showing or 
hiding the section.

Display Options
Multiple instances of the Bus Tools plug-in are displayed in one large window. Right-click onto the window 
title bar of the plug-in to open a menu offering some general display options for the Strip Tools plug-ins:

Strip Tools - General Display Options
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This menu allows you to either directly select the number of strips displayed in the plug-in window, or to 
increment/decrement this number by one. The maximum number will vary depending on how many Strip 
Tools are assigned. 

Linking Strip-Tools controls
Any choice of Strip Tools controls can be linked together. When you move any of the controls which is a 
member of a link group, all the other members of the group also move. There are 48 link groups for linear/
rotary controls and 48 link groups for switches. 

To add a control to a link group, right-click on the knob or button to display its Link Status and Automation 
Status pop-up window. E.g. this is the pop-up for an input gain control.:

Group assignment mode buttons
These four buttons define the link mode of the control. Four choices are available:

None The control is not a member of any group.

Group The control is a member of the selected group. When you move (or switch) this 
control or any other control which is a member of this group, all the members of 
the group will move (or switch) along with it.

Exclusive This mode is only available for switches. With this mode selected, when this 
switch is on, all the other members of the group will be switched off.

Group Exclusive This is a mode which has a superior effect on all groups which are set to Group 
Exclusive. When any of the groups which are set to Group Exclusive is 
switched on, all the other groups set to Group Exclusive will be switched off.

Strip Tools - Link and Automation Status
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Grouped controls are indicated by a yellow L in the corner of the control ‘block’.

Factor X Slider Works only on continuous (rotary or linear) controls. It determines the gearing 
of this control in relation to other members of the group and vice versa. E.g, 
assume the input gain of strip tools #1 and the input gain of strip tools #2 are 
both assigned to group one. The scale factor of the gain of strip tools #2 is set 
to 2. Now when you change the gain of strip tools #1 by 1 dB, the gain of strip 
tools #2 will change by 2 dB’s.

Invert Also works only on continuous controls. It inverts the effect of the movement 
for this control caused by another group member or vice versa. E.g, assume 
the input gain of strip tools #1 and the input gain of strip tools #2 are both 
assigned to group one. The invert button of the gain of strip tools #2 is on. Now 
when you increase the gain of strip tools #1 by 1 dB, the gain of strip tools #2 
will diminished by 1 dB.

Automation mode switches
When a grouped control is clicked, all other members of the group are shown with a yellow box around 
them. 

Offset
If controls are offset when grouping is turned on, they retain the offset as shown here.

The red bar at the top of the strip indicates it is selected. The grayed out knob is the one which was right-
clicked.

Strip Tools - Grouped  Controls

Strip Tools - Grouped  Knobs
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Sections
From top to bottom, Strip Tools contains the following Sections:

Input Level
This section contains the input level control and shows the name of the mixer 
strip this instance of the plug-in is assigned to.

Dynamics
This section contains a compressor. It can be switched, as shown here, to act as 
a decompressor. 

Expander
This is a downwards expander. It can also be switched to act as an upwards 
expander.

Equalizer
This is a five band fully parametric equalizer. Each band can be switched to high 
or low pass, shelving or peaking characteristics.

Output
This section controls the output level of the strip tool and also offers automatic 
gain make up for the compressor.

Common Features
Each Section or module of Strip and Bus Tools has a number of controls in common.

Title Bar
A text description of Section’s function, e.g. Input, Dynamic etc. Also contains:

Show/Hide triangle
At top left of every Section a grey triangle toggles between showing or hiding the section. Clicking a triangle 
with Shift held down opens the Section (If hidden) and hides all other Sections. Clicking a Section with Ctrl. 
held down opens all Sections.
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Note: Sections remain active when hidden.

Section On/Off Button
Between the Show/Hide triangle and the Section Title is the On/Off button for the Section.

Knobs
The position indicator dot lights orange when the control is at the default value. A white star appears top-left 
of the scale of the last control ‘touched’. 

Input Section

Color Bar
Indicates strip is selected.

Strip Name
Displays the name of the strip the plug-in is assigned to. The name for the plug-in can be changed by dou-
ble-clicking on the strip name, then typing in a name and hitting the Return key to confirm. If a plug-in 
name is changed in this way, subsequent changes to the parent mixer-strip name do not affect the plug-in 
strip name. To recover the name of the parent strip, simply remove the strip name.

The strip name is saved with presets and within Pyramix projects.

Activate/deactivate plug-in
This button switches the entire Strip plug-in on or off. Note that when the plug-in is switched off, it doesn’t 
consume any DSP power.

Show/Hide input section
Input section on/off
Input level control
Adjusts the input level over a range of -48 dB to +48 dB.

Show/hide Routing
By default Routing buttons are hidden. This button toggles between Showing and Hiding the Routing But-
tons. Routing remains active when hidden.

Routing Buttons
Determine which audio streams running through the strip will be processed by the plug-in. The number of 
buttons depends on the number of steams controlled by the strip. This means one for a mono input channel 
or two for a stereo input channel and so on up to 8 for a 7.1 input channel. Streams which are not selected 
will be left untouched.

Strip Name

Show/Hide Input Section

Input Level Control

Activate/De-activate Plug-in

Input Section On/Off

Show/Hide Routing

Routing Buttons

Color bar indicates Selected
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Dynamics Section

Show/Hide Dynamics section
Dynamics Section On/Off
Gain reduction display
The bar graph shows the gain reduction/increase generated by the Dynamics Section or by the 
Expander. The range of the display can be switched between +-10 or 20 dB by clicking on the bar graph. 
Scale markings in 1dB increments on the right-hand side of the bar graph make it easy to see if the range 
is 10 or 20 dB. 

Colors are used to denote a gain reduction or increase generated by either the compressor or the 
expander:

• Gain reduction by the Compressor is displayed in Red from top to bottom.

• Gain increase by the De-Compressor is displayed in Pink from bottom to top.

• Gain reduction by the Expander (normal or inverse) is displayed in Green from bottom to top. With 
the compressor in inverse mode, the gain reduction of the expander is displayed in Green from top to 
bottom

Threshold Level Control
Sets the level at which the compressor begins to act. If the input signal level exceeds the Threshold Level, 
the gain is reduced (or increased in De-Compressor mode) in proportion to the setting of the ratio control.

Ratio Control
Determines the proportion of gain reduction (or increase) for signals above the threshold level. If, for exam-
ple, the ratio is set to 2.00:1, in Compressor mode, if the input level rises by 2dBs above the threshold level, 
the output level will only rise by 1 dB.

Attack Time Control
Controls the time the compressor takes to react when the input level exceeds the Threshold Level. The 
lower the attack time, the faster the reaction.

Release and Hold Time controls
These two parameters work together and control the amount of time the compressor takes to react when 
the input level is above the threshold level and starts fall. During the hold time the gain of the compressor 
remains constant. After the hold time the gain of the compressor is changed at the rate set by the release 
time. The lower the release time, the faster the reaction.

Show/Hide Dynamics Section

Gain Reduction Display

Threshold Level Control

Ratio Control

De-Compress Switch

Dynamics Section On/Off

Attack Time Control

Release Time Control

Hold Control
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De-Compress Switch
Switches the compressor between the compress and the de-compress modes.

In compressor mode, when the input level exceeds the threshold level, the gain is reduced according to the 
setting of the ratio control. In de-compressor mode, when the input level exceeds the threshold level, the 
gain is increased according to the setting of the ratio control.

Expander Section

Show/hide Expander section
Dynamics section on/off
Threshold Level Control
If the input signal level falls below the threshold level, the gain of the expander is reduced (or increased in 
inverse mode) according to the setting of the ratio control.

Ratio control
Determines the proportion of gain reduction (or increase) for signals below the threshold level. If, for exam-
ple, the ratio is set to 2.00:1, in normal mode the output level will be decreased by 2 dB if the input level is 
decreased by 1 dB below the threshold level.

Compressor and De-Compressor action

Threshold

Input level

Output level

Threshold
Input level

Output level

Compressor mode De-compressor mode

Show/Hide Expander Section

Threshold Level Control

Expander Section On/Off

Ratio Control

Inverse Switch
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Inverse switch
Switches the between normal and inverse expander modes.

Attack/Release/Hold controls
The Expander Section uses the settings of the Attack/Release/Hold controls in the Dynamics Section to 
control it’s timing.

Equalizer section
A fully parametric five band equalizer. Each band covers the entire frequency range from 20 Hz to 20 kHz 
(or higher, depending on the sampling rate of the project) and can be switched between peaking, high or 
low shelving and low-pass or high-pass characteristics. Each of the five bands can be switched off. De-acti-
vated bands do not consume DSP power.

Show/ Hide EQ Section
EQ section on/off
Pre Dynamics Switch

Threshold
Input level

Output level

Threshold

Input level

Output level

Expander normal mode Inverse mode

Expander normal and Inverse mode action

EQ Section On/Off

Band Filter Type

Band Selector

Gain Control

Frequency Control

Show/Hide EQ Section Pre-Dynamics Switch

Graphic Display Window

Selected Band On/Off

Q (Bandwidth) Control
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This switch offers the option to the switch the EQ before the dynamics section. By default the EQ is after 
the dynamics section.

Graphic Display Window
This small window displays the settings of the currently selected EQ band in blue color and the resulting 
curve of the whole EQ section in gray color. You can click and drag directly onto the handles (the small blue 
or gray points) of the EQ bands to change the settings within the graph window. 

Double-click anywhere in the window to open a bigger version. Please see The Big Graph Window  on 
page 144.

Band Selector
Click onto one of these five buttons to select the band to be manipulated by the Gain, Frequency and Q 
control underneath. A band gets also selected if it is manipulated in the small or big graph window.

Selected band characteristics
These five buttons determine the characteristics of the selected EQ band. The choices from left to right are 
High-Pass Filter, Low Shelving, Peak, High Shelving and Low-Pass Filter.

Selected Band On/Off
Switches the selected EQ band on or off. By default the five bands are switched off in order to economize 
DSP power, so don’t forget to switch an EQ band on before you can hear what it is doing.

Gain Control
-24 dB to +24 dB, boost and cut.

Frequency Control
The range for each band is depending on the sampling rate of the project:

• For sampling rates up to 48 kHz the frequency range of each band is 20 Hz to 20 kHz.

• For sampling rates up to 96 kHz the frequency range of each band is 20 Hz to 40 kHz.

• For sampling rates up to 384 kHz (e.g. DSD mixing) the frequency range of each band is 20 Hz to 
80 kHz.

Q (bandwidth) Control
The range for the Q parameter is 0.2 up to 100. A Q of 0.2 results in a very wide bandwidth, a Q of 100 will 
give an extremely narrow notch.

Output Section

Show/ Hide Output section
Output section on/off
Output Level control
Adjusts the output level over a range of -48 dB to +48 dB.

Output Level Control

Show/Hide Output Section Output Section On/Off

Auto Gain Make-Up Switch

Color bar indicates Selected
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Automatic Gain Make Up switch
When lit, Output gain is automatically adapted according to the settings in the Dynamics Section. In this 
case the Output Level Control will be grayed out and inaccessible.

The Big Graph Window
The big graph window opens when you double-click the small graph window inside the EQ Section. The 
current settings of the selected EQ band are displayed as a blue line and the resulting overall EQ curve is 
displayed as a gray shaded area. Frequency and Gain parameters of each of the five bands can be altered 
by clicking on a band’s handle and dragging with the mouse. Handles of bands which are not selected are 
displayed as small gray squares. Grabbing and drag a handle selects the band.

The frequency response display uses two separate gain scales. The left hand, blue scale shows the scale 
used for individual bands. The right hand, gray scale shows the scale for the overall EQ curve. Both scales 
automatically adapt their range according to the settings of the curves they apply to. The range of the left 
and the right scale my be different. The ranges for the individual bands can be either +/- 6 dB, +/- 12 dB or 
+/- 24 dB, but the scale for the overall curve may go up to +/- 72 dB.

The upper area of the Big Graph Window provides an On/Off switch and buttons to select and indicate 
the characteristic (High-Pass, Low Shelf, Peak, High Shelf or Low-Pass) for the selected EQ band together 
with numeric displays of Gain, Frequency and Bandwidth.

Frequency and Bandwidth setting.
Shortcuts
• Double click on a handle to reset the gain of this band to unity.

• The Tab key switches between EQ bands.

• Clicking and dragging a handle with the right mouse button alters the Q (bandwidth) of this band.

• Hold the Ctrl key while dragging with the left mouse button to lock the gain parameter and only 
change the frequency.

• Hold the Shift key while dragging with the left mouse button to lock the frequency parameter and 
only change the gain.

Big Graph floating Window
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Bus Tools

Bus Tools are very similar to Strip Tools but are specifically designed to be inserted into busses rather 
than channels. Bus Tools combine the most frequently used ‘mastering’ processing blocks you find on the 
output busses of a mixing console in a single plug-in, including an advanced limiter. Like Strip Tools multi-
ple instances of the Bus Tools plug-in are displayed in one large window. The number of instances dis-
played is user selectable.

IMPORTANT! Pre-Anticipation (PA) and Delay Compensation (DC)
Delay compensation adds a delay determined by the Pre-Anticipation delay setting to all channels passing 
through a Bus Tools plug-in NOT selected for processing.

If two or more Bus Tools are inserted in a Bus with PA & DC on, the delay times of each Bus Tools will add 
together for all channels:
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Sections
The Input, EQ, and Output sections are almost identical to the ones found in Strip Tools. Please see the 
relevant paragraphs in the Strip Tools section for a full description. Where there are differences, these will 
be dealt with here. Shortcuts, Linking and Automation functions are the same as Strip Tools.

From top to bottom, the Bus Tools plug-in contains the following sections:

 

Input Level
This section contains the input level control and shows the name of the mixer 
strip this instance of the plug-in is assigned to.

Limiter
This section contains the limiter, which either acts as a standard limiter, but it 
can also work in conjunction with Limiter DRC section below.

Limiter DRC
This section adds a Dynamic Release Compensation (DRC) to the Limiter sec-
tion. This enables very musical control of the release time of the limiter.

Equalizer
This is a five band fully parametric equalizer. Each band can be switched to high 
or low pass, shelving or peaking characteristics.

Output
This section controls the output level of the Bus Tool and also offers automatic 
gain make up for the Limiter.
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Main and Input Level Section

Strip Name
Activate/Deactivate Plug-in
Show/Hide input Section
Input Section On/Off
Input level control
Adjusts the input level over a range of -48 dB to +48 dB.

Show/hide Routing
By default Routing buttons are hidden. This button toggles between Showing and Hiding the Routing But-
tons. Routing remains active when hidden.

Routing Button Matrix
The buttons determine which audio channels running through the Bus will be processed by the plug-in. The 
number of buttons shown depends on the number of channels controlled by the Bus. In the case of a multi-
ple surround Bus this may be up to 64. A single instance of Bus Tools can process up to 8 channels 
selected from this matrix.

A 5.1 surround bus will have six buttons. The order of the channels selected by the buttons is (from left to 
right): Left, Center, Right, Left Surround, Right Surround, Subwoofer.

This enables, for example, the Left, Center and Right channels of a surround Bus to be independently pro-
cessed from the surround channels by adding two Bus Tools plug-ins to the Bus and selecting L, C, R in the 
first and LS and RS in the second.

Using Bus Tools on multiple surround busses
Although a single instance of Bus Tools can process 8 channels it is simple to use multiple instances to pro-
cess many more with linked parameters. E.g. with four surround Busses you could use 3 instances. Assign 
the L & R channels of each Bus to Bus Tools A, the Centers of each bus to Bus Tools B and the Surround 
Ls and Rs of each Bus to Bus Tools C. The 3 Bus Tools can then be linked as you wish by right-clicking and 
creating control groups in the yellow matrix. If Delay Compensation (see below) is activated all channels 
will remain time-aligned, even when using Pre-Anticipation.

Delay Compensation
Delay Compensation
When the DRC section is active, the plug-in introduces a small delay to the audio signal. Since some sig-
nals of a bus may not be selected for processing using the routing buttons, these signals would not be 
delayed, and there would be a time misalignment at the output of the bus. When Delay Compensation is 
on, the same delay is applied to all signals whether selected for processing or not. This results in correct 
time alignment for all the signals of a bus.

Strip Name

Show/Hide Input Section

Delay Compensation

Input Level Control

Activate/De-activate Plug-in

Input Section On/Off

Show/Hide Routing

Routing Button Matrix
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Limiter section
This is a straightforward ‘brick-wall’ limiter with simple Threshold and Release parameters. However, the 
DRC (Dynamic Release Compensation) feature described in the next section can be activated to allow very 
musical control of the release time.

A brickwall limiter is a limiter which guarantees that the output level will never exceed the threshold level. 
On a normal limiter, a high level signal with very fast attack might cause an output higher than the threshold 
level, with a brickwall limiter this will not happen.

Show/Hide Limiter section
Limiter section on/off
Gain reduction display
The bar graph shows the gain reduction generated by the Limiter Section. The range of the display can be 
switched between 6 or 12 dB by clicking on the bar graph. Scale markings in 1dB increments on the right-
hand side of the bar graph make it easy to see if the range is 6 or 12 dB.

Threshold control
If the input signal level rises above the threshold level, the gain of the limiter is reduced. This limiter guaran-
tees that at no time will the level of the output signal exceed the threshold. 

Release control
This parameter controls the amount of time the limiter takes to release. I.e remove the gain reduction) when 
the input level was above the threshold level and starts fall. During the hold time the gain of the compressor 
remains constant. The lower the release time, the faster the reaction.

Limiter DRC Section
DRC stands for Dynamic Release Compensation. In short, this means the release time of the limiter is 
altered depending on the dynamic nature of the signal routed through the processor.

Show/hide DRC section

Show/Hide Limiter Section

Gain Reduction Display

Threshold Control

Limiter Section On/Off

Release Control

Show/Hide DRC Section

Release Acceleration or
Modification Display

Velocity Control

DRC Section On/Off

Gain Reduction Bargraph

Dynamics Bargraph

Curve Control

Lookahead Delay Control

Offset Control
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DRC section on/off
Release Acceleration or Modification Display
Shows a curve which illustrates the relationship between the change in dynamics of the input signal and the 
variation of the release time. The curve can be adapted between linear and power function characteristics 
(see also the description of the Curve Control parameter). During playback the display will also show a 
small red ball moving along the curve. This shows the range the algorithm is working in.

Gain reduction bargraph
Displays the gain reduction of the limiter while the DRC circuit is active. The scale is fixed at 6 dB.

Dynamics bargraph
Displays the dynamics of the input signal, which is the basis for the DRC algorithm.

Velocity control
Determines the speed of the DRC algorithm. The lower the value, the faster the algorithm reacts to 
changes of the dynamics of the signal and the more it reacts to dynamics the more the release time will 
remain constant.

Offset control
This parameter basically sets the minimum release time. In this sense the release control of the limiter 
defines the maximum release time, so the release time determined by the DRC algorithm will vary between 
these two times.

Curve control
This parameter controls the characteristics of the relationship between the dynamics of the signal and the 
resulting release time 
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Pre-Anticipation (Lookahead delay) control
This parameter changes the integration time for RMS detection and thus changes the effect of the DRC cir-
cuit.

The delay setting here also determines the delay that will be applied to signals passing through the plug-in 
NOT not be selected for processing when Delay Compensation is switched ON 

Note: Please note that this parameter delays the all signals running through the Bus Tools 
plug-in, so phase or other timing errors may occur when the plug-in is used in places other 
than the mix bus.

EQ and Output Sections
These are identical to the Strip Tools versions.

It is worth noting that, since the Limiter is in this case a brickwall design, the Automatic Gain Make-up func-
tion compensates for the same amount as the value set by the Threshold Control of the Limiter. The 
resulting signal will be close to, but never exceed 0dBfs. If Gain Make-up is Off the Output Level Control 
will act as a ‘ceiling’ control, setting the absolute level of the resulting output signal.

Delay Compensation / Pre-Anticipation

Example

In this table Bus Tools Instance 1 is IN circuit for the Left and Right channels of the mix and Bus Tools 
Instance 2 is IN circuit for the Left Surround and Right Surround channels. For the Center and Sub-Woofer 
Channels both Bus Tools are OUT of circuit. BUT Pre-Anticipation and Delay Compensation is switched 
ON for the channels selected for processing. To ensure proper time alignment all channels are automati-
cally delayed by the same total amount. (the 8.71 and 5.8 figures are arbitrary)

If all channels are selected for processing (in circuit) with linked Pre-Anticipation then there is no need to 
activate Delay Compensation.

5.1 Surround Mix Bus using two Bus Tools
Channel BUS 1 BUS 2 BUS 3 BUS 4 BUS 5 BUS 6

Routing L C R SL SR SW

Instance 1 IN OUT IN OUT OUT OUT

Delay 8,71 (PA) 8.71 (DC) 8,71 (PA) 8.71 (DC) 8.71 (DC) 8.71 (DC)

Instance 2 OUT OUT OUT IN IN OUT

Delay 5.8 (DC) 5.8 (DC) 5.8 (DC) 5.8 (PA) 5.8 (PA) 5.8 (DC)

Total Delay 14.51 ms 14.51 ms 14.51 ms 14.51 ms 14.51 ms 14.51 ms
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14 Pyramix Mixer Settings

Mixer

Level Meter
This page determines the appearance and behavior of the level meters in the Mixer and Track Headers. 

These settings only apply to the current Mixer. This allows each Mixer to have its own custom General and 
Level Meter settings.

To change any of the settings, click the left or right buttons or drag the horizontal scroll bar to increment or 
decrement the selected parameter. Alternatively, type directly into the number field for each parameter 
(these fields will only accept numbers within the permissible range for each parameter). The color graphic 
display of the level meter will respond immediately to show the effect of Headroom and Alignment parame-
ter changes.

Headroom
Sets the amount of headroom displayed as red meter segments before clipping.

All Settings Project Mixer Level Meter Page
 Pyramix Mixer Settings 14 - 151



Ramses MSC reference guide
Pyramix Mixer Settings : Mixer
Alignment
Sets the alignment level. Displayed by the point on the scale at which the dark orange segments begin.

Peak and Overload Hold Time
Sets the amount of time in seconds that the peak segment or overload segment (topmost red segment) of 
the level meter remains illuminated.

Permanent Overload
When the box is checked, the red Overload LED above a track will remain lit, even after playback is 
stopped. To clear the LED, double-click it. When not checked, the Overload LED will automatically clear 
itself after a few seconds and remain off until the next overload occurrence.

Note: The overload LED will go on after one sample with the maximum level.

Permanent Peak
This parameter works in conjunction with the Peak Level Display. When this is on (checked), the Peak 
Level pop-up display will show the value and location of the highest level reached on a track up to the time 
when the mouse was clicked on the meter. The level display will not be updated until the next time playback 
is stopped and re-started. If it is not on (unchecked), the Peak Level Popup Display will show the highest 
level reached in that track from the last time the Popup Display is activated (while playback continues). For 
example, clicking a channel’s meter while playing back will display the Peak Level Popup, which will show 
the peak level (and its location) reached so far. Click away from the Popup, and it will disappear. Click on 
that meter again, and the Popup will appear again, this time showing the peak level/location reached since 
the last time the Popup was displayed.

Decay integration time
This parameter sets the rate at which the level meter display decays after the level falls below the most 
recent peak. The slope of the decay is given in terms of milliseconds per decibel (ms/dB).

Peak level indicator
Show After
When the box is checked, the Fader/Input Level displays located above the faders on each mixer strip dis-
play the peak level of the signal running through the corresponding mixer strip. The value are updated at 
the interval set by the slider below the check box. If the check box Show After is off, the Fader/Input Level 
displays always show the setting of their corresponding fader.

DSD Peak Filter
For DSD projects this drop-down list offers the choice between two filtering options which will be applied to 
the DSD signal before it is measured by the level meter.

This will help enable you to ensure that the DSD signal is compatible with the AES recommendations con-
cerning the high frequency dither noise content. 

20k
Applies a 20 kHz low pass filter to the signal, thus only the audible audio content is measured.

40k-100k
Applies a band pass filter with a frequency range of 40 kHz to 100kHz to the signal. According to the AES 
recommendation the signal level in this frequency range should not exceed -20 dB.
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DSP Power Saving

Special Modes
Player/Recorder Mode
This mode allows big configurations (such as 48 x 48 channels) to run on a single board. Player/Recorder 
Mode is intended for use with an external hardware console. When this mode is activated, the Pyramix 
mixer is relegated to the role of signal router, there is no level control, no panning, no plug-ins and no 
inserts. This option is only available in configurations with multiple mono mix busses.

The Pyramix Direct Out functionality provides an alternative, more user configurable method of achieving 
similar DSP savings. Please see: Channel Direct Outputs  on page 164

DSP Time Saving
Disable the Punch in/out
When the box is checked, Punch-in and out recording capabilities are disabled.

Important!  Pyramix still will allow you to arm tracks and to start the recording process, but the 
resulting media file will contain digital nulls.

Disable Mix Down
When the box is checked, the digital mixdown function activated with the menu command Project->Mix 
Down is disabled.

Important!  Pyramix still will allow you to start the mixdown process, but the resulting media file will 
contain digital nulls.

All Settings Mixer DSP Power Saving Page
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Mixer Settings

Delay Compensation Policy
Mode
The drop-down menu offers a choice between:

Full Delay Compensation
All but effects latencies
Off

Note: Automatic Delay Compensation does not support more than 3 nested I/O loops.

Automatic Delay Compensation
When ticked, turns Automatic Delay Compensation On

Note: Any changes to the delay required that occur during playback or recording will only 
be computed and applied when the Transport is next in Stop.

Max Mixer Delay Compensation
When required by the Mixer error: Delay compensation dialog the slider should be set to a value just 
above the delay latency value requested.

Reset to Factory
Click the button to restore the factory computed maximum delay value.

All Settings Mixer Mixer Settings Page
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Plug-ins Settings

VST Plug-ins
The buttons offer a choice of how the VST Plug-ins are ordered and grouped in the Plug-ins List Menu.

If Company Name and I/O Configuration is chosen the list will be ordered by Company Name and the 
plug-in’s grouped according to their I/O configuration. I.e. 1 in - 1 out, 1 in - 2 out, 2 in - 2 out and so on.

Alternatively, choosing I/O Configuration groups the Plug-ins by I/O Configuration and within each group 
lists them alphabetically by name.

All Settings Mixer DSP Plug-ins Settings Page
 Pyramix Mixer Settings 14 - 155



Index

Symbols
(Post Panel) Edit Bay configuration  18

A
a/b button  60
active button  58
active dual-concentric encoders  58
Active Screen  58
Add to Group button (+)  44
Adding Strips  124
All button  40
Alt button  90
ARC Modifier button - Mute  50
Arc Type  17
arm button  50
ARMED TRACK INDICATOR  23
auto button  57
AUTOMATION STATE INDICATORS  23
Autosave time  17
Aux button  54
aux IP  27
aux on/off  27
aux PF  27
aux select  26

B
bank nudge buttons  54
Basics  11
Bus Peak Meters 1 - 6  30
Bus Returns

Recording  122
Buses Repro button  107

C
Chair button  41
CHANNEL METER  23
channel nudge buttons  54
CHANNEL NUMBER  23
CHANNEL TYPE INDICATORS  23
clear touch point  60
Configuring a blank or existing mixer  124
Creating and Configuring Mixers  117
Ctrl button  90
Cycle  34

D
daw 1 button  57
daw 2 button  57
daw 3 button  58
daw 4 button  58
Delay  116
Delay Compensation  121,  145
Delay Compensation Policy  154
Dim Encoder / Button (press) and Indicator  32
Disable Mix Down  153
Disable Punch in/out  153
Dithering Window  128
DSD Peak Filter  152
DSP Time Saving  153
dual-concentric encoders  58

E
Edit Bay  86

Editor - RH side  91
Editor LH side  90
General Overview  87

edl list  90
end button  49
Engine IP address  18
Engine Type  17
ENTER button  90
Envelope button  90
EQ Aux and Pan Strip  25
EQ Fan Spoke Values  28
EQ Fans  28
EQ Panel  24
EQ Strip  25
Ergonomic Spread buttons 1-4/5-8  44
even more butto  57
Expert Panel  39
External Effects  124
External Metering  70
External Sources 1 to 5 and “+”  30
External Sources in Pyramix  38

F
Fader  116
FADER DISPLAY  23
Fader Strip  23
Faders, Mute & Other indicator  48
156 Index 



Index :
fine button  91

G
gain button  90
grab button  90
Group button  45
grp - bus 1 - 24 select buttons  61

H
Hide Mouse Cursor  17
HOLD BUTTON  23
hold button  49
HPF Indicator  28

I
In & Out buttons  91
INJECT TOUCH POINT  23
Input Strip Mode  122
insert button  60
Inserts, External Effects  100
Introduction  8
isolate button  51

J
Jog button  91
joystick panner  61

L
L & R panner select buttons  61
Left-Right buttons  91
library button  57
load project  11
Locate button / Scene loc  35
locate buttons  61
Lock Edit Panel  90
Lower Active Panel  59
LPF Indicator  28

M
m1 & m2 buttons  51
machine button  57
Main Monitor Volume Encoder  32
Mark  34
Master EQ  28
Master eq  26
Media Manager Monitoring  69
Meter Bridge

Automation Fader Mode and Group Indicators  85
Configuration  82
Global Mute and Solo Indicators  82
Switch  80
Window  81

Meter Bridge Setup in Pyramix  38

mix - bus A - F select buttons  61
mix - cut surround channel buttons  61
Mix button  55
Mix Sources A to E  30
Mixer Configure  124
Mixer error

Delay compensation  121
Mixer Presets  129
Mixer Surround Components  130
mod button  60
Model Number  17
Modifier button - mod  40
Monitor

Adding an External Machine  71
Buses / Externals button  63
External Inputs  71
Output Patch  68
Talkback  72
Talkback Page  73

Monitor !  62
monitor button  57
Monitor Configure page  66
Monitor Mute / SOLO buttons L, C, R, LS, RS, SUB  31
Monitor Panel  29
Monitor Setup in Pyramix  37
more button  57
More Indicator  26,  28
Mount  90
MUTE BUTTON  23
mute button  60

N
next button  49
Normalize  90
NULL INDICATORS  23
Numeric Keypad (not Pyramix)  35

O
Out of Range  28
Output assignment shown in orange  68
Output Metering Patch - External Meters  66

P
pan  27
personal button  57
pfl/afl button  40
phase reverse button  60
Player/Recorder Mode  153
plug-ins button  57
Position/Speaker Control  132
Pre-Anticipation  145
Pyramix

AUX Buses In-Place Panning  114
Aux Send Routing  113
Basic Mixer  104
 Index 157



Index :
Bus Tools  145
Bus Tools Pre-Anticipation  150
Bus Tools Sections  146
Configure page Meter Bridge switch  95
Creating and Configuring Mixers  117
Default Mixer  130
Effect management  98
Eq, Comp/Limiter/Expander  135
External Effects Inserts  100
In-Place Aux Panning Source  114
Knobs  139
Level Meter  151
Meter Alignment level  152
Meter Decay integration time  152
Meter Headroom setting  151
Meter Permanent Overload  152
Meter Permanent Peak  152
Mix Bus  107
Mixer  93
Mixer Adding Strips  124
Mixer Auto-Select  106
Mixer Aux Busses  111
Mixer Basic Strip  116
Mixer Bus + - context menus  105
Mixer Bus Path Colors  106
Mixer Buttons  116
Mixer Channel Direct Outputs  110
Mixer Components  107
Mixer Configuration Further Options  126
Mixer Configuration Page Settings  94
Mixer Configuration Summaries  95
Mixer Configuration Wizard  118
Mixer Configure page  94
Mixer Context Pop-up menu  126
Mixer Delay Comp Mode  95
Mixer Delay Compensation  120,  122
Mixer Delay Compensation of External Inputs  123
Mixer Delay vs Delay Compensation  123
Mixer Determining Delay Compensation for External Effects

Loops  123
Mixer Direct Output  116
Mixer Direct Outputs  95
Mixer Dither Type  128
Mixer Dither Word Length  128
Mixer Dithering Options  128
Mixer Effects Delay indication  124
Mixer Expand / Collapse  104
Mixer External Insert  126
Mixer Groups  110
Mixer I/O Assignments  124
Mixer I/O Busses  119
Mixer Input Assignment  116
Mixer Input Strip Types  119
Mixer Input Strips  107
Mixer Internal Return Busses  119
Mixer Maximum Delay Compensation  121
Mixer Mono Mix  107
Mixer Multiple Mix Busses  108
Mixer Multiple Stereo Mix  107
Mixer Noise Shaping  129

Mixer Organize Page  101
Mixer Pages  93
Mixer PDF (Probability Density Function)  128
Mixer Plug-ins  125
Mixer POW-r  129
Mixer Presets  129
Mixer Removing Strips  124
Mixer Route Page  102
Mixer Set All ON/Off  105
Mixer Set All to 1st Stem  105
Mixer Settings  154
Mixer Show Distribution  94
Mixer Stereo Mix  107
Mixer Strip & Bus Types  110
Mixer Surround Components  130
Mixer Surround Control window

Level Meter  132
Link  133
Stereo Surround Control  133
Surround Meter  133
Surround Panning Algorithm  132

Mixer Surround Mix - 5.1  108
Mixer VS3 Native Plug-ins  125
Mixer VST Plug-ins  125
Mixing/Monitoring/Aux Buses  107
Multiple Surround Mix  109
Peak and Overload Hold Time  152
Peak level indicator  152
Plug-ins Settings  155
Recording Bus Returns  122
Removing Mixer Presets  130
Saving / Loading Mixer Presets  130
Selecting, Copying and Moving Effects  100
stem mixing  109
Strip and Bus Tools  135

Delay Compensation  147
Display Options  135
Group assignment mode buttons  136
Linking Strip-Tools controls  136
Modules  135
Routing Button Matrix  147
Sections  138

Surround Components (Mixer)
Joystick Panner  130
LFE Level  130
Speaker Controls  130
Strip and Bus Tools  134
Surround Stem select  131

Surround Control window  131
Pyramix Mixer

Configure Strip and Bus operations  96

R
read button  51
Recall button  44
 Index 158



Index :
Recall TimeCode  35
Redo  42
reference level  32
release button  49
Release time knob  48
Repro button  107
Rim Light  28
Rotary Controls  116

S
safe button  57
scene button  57
Scope  86
Select button  91
Shelf  28
shelf  26
Shift button  91
Shift Order  100
Shuttle button  91
SIP button  41
Skin Version  17
snap button  49
snap range  50
snapshot  49
solo button  60
Solo Clear touch point  41
SOLO TOUCHPOINT  23
Speaker Delays  68
Speaker Sets  64
Speaker Sets and Downmix  31
Special Modes  153
Store button  43
Store TimeCode  34
Storing and Recalling Mixer Presets  129
Storing New Mixer Presets  130
Strip and Bus Tools

Automation mode switches  137
strip number display  60
Subtract from Group button (-)  48
Surround Components (Mixer)

Stereo Input Strips Surround Panner  131
Surround Control  131
system button  57

T
TALKBACK  33
Talkback  72

Example  74
Reset  78
Talk to All  78

Talkback in Pyramix  38
Talkback Page  73
template button  57
Terminology  11
TimeCode Display  33

timmometer  57
Touch button  42
Track Selection and User Keys  92
Transport Controls  36
transport controls  61
Trim button  91
trim button  49

U
Undo  42
unity button  50
Up-Down buttons  91
Upper Active Panel  56

V
View and Modifiers  92

W
write button  51

X
X-Fade button  91

Z
Zoom button  91
zoom button  61
 Index 159


	Contents
	1 Introduction
	Scope
	Document Organisation
	Updating
	Other Documents

	Terminology
	Panels
	The Basics
	How to turn your Ramses On
	How to turn your Ramses Off
	How to load your project
	Tips and tricks


	2 Ramses Setup
	Scope
	Setting up Ramses with Pyramix
	Upgrading Ramses Software and Firmware

	Setup
	Engines
	Stems
	Errors
	Info
	Configure
	Versions
	Firmware
	Network
	Shutdown
	Exit

	Configure sub-menu

	3 Fader Panel
	Overview
	Fader Strip

	4 EQ Panel
	Overview
	EQ Aux and Pan Strip
	1 shelf
	2,3 and 4 HF, MF and LF eq eq display
	5 shelf
	6 Master eq
	7 More Indicator
	8 aux select
	9 aux knob
	10 aux IP
	11 aux PF
	12 aux on/off
	13 pan
	EQ Summary.
	EQ Fan Spoke Values


	5 Monitor Panel
	Monitor Panel Overview
	Meter Bridge
	Tips and tricks
	Summing
	Tips and tricks
	Summing
	Mute
	Solo
	surround
	stereo
	near
	down-mix
	Tips and tricks
	14 Slate button
	15 Talk 2
	16 Talk 1
	Overview
	How to use the Talkback Functions:
	Tips and Tricks
	Monitor Setup in Pyramix
	Tips and tricks
	External Sources in Pyramix
	Talkback in Pyramix

	Meter Bridge Setup in Pyramix
	Tip


	6 Expert Panel
	Expert panel Overview
	Expert Panel Overview
	ALL button indicator


	7 Upper Active Panel
	Upper Active Panel Overview
	1 timmometer knob
	2 scene button
	3 template button
	4 personal button
	5 system button
	6 auto button
	7 library button
	8 safe button
	9 plug-ins button
	10 machine button
	11 monitor button
	12 more button
	13 even more button
	14 daw 1 button
	15 daw 2 button
	16 daw 3 button
	17 daw 4 button
	18 Active Screen
	19 dual-concentric encoders
	20 active dual-concentric encoders
	21 active button

	8 Lower Active Panel
	Lower Active Panel

	9 Pyramix Monitor Section
	Monitor ! Window
	Scope

	Monitor ! page
	Sources, left-hand section:
	Main, centre section:
	Output, right-hand area
	Speaker Sets

	Configure page
	Available Sets
	Commands
	Output Patch:
	Double Assignment
	Speaker Delays
	Saving Speaker Sets


	Media Manager Monitoring
	External Metering
	External Inputs
	Adding an External Machine

	Talkback
	Setting Up
	Talkback Page
	Example
	Setting Up
	Operation

	Foldback


	10 Meter Bridge
	Scope
	Meter Bridge Switch
	Meter Bridge Window
	Resize
	Global Mute and Solo Indicators
	Selected Strip and Record Ready Status
	Configuring the Meter Bridge
	Layout
	Strips
	Buses
	Externals
	Meters Zoom
	Meters Type

	Automation Fader Mode and Group Indicators
	Ramses Group
	Automation Fader Mode



	11 Edit Bay
	Introduction
	Scope
	Software Versions

	General Overview
	The Editor
	Navigation
	Modifiers - Left-hand Side
	Modifiers - Right-hand side
	Editor - Left-hand side
	Editor - Right-hand side

	Track Selection and User Keys
	View and Modifiers

	12 Pyramix Mixer
	Overview
	Mixer Pages
	Configure Page
	Settings
	Mixer Configuration Summaries
	Direct Outputs
	Selecting Strips

	Strip and Bus operations
	Productivity Shortcuts

	Effect Management
	Configure: Effects Buttons
	Effects Section Containers

	External Effects Inserts

	Organize Page
	Presets

	Route Page
	Making Connections
	Info
	Automate Page

	Mix !
	Basic Mixer
	Expand / Collapse
	Collapse/Hide
	Resets
	Bus + - context menus
	Colors

	Mixer Components
	Input Strips
	Mixing/Monitoring/Aux Busses
	Mix Bus
	Multiple Mix Busses

	Groups
	Channel Direct Outputs
	Strip & Bus Channel Types
	Aux Busses:
	Aux Send Routing
	Aux Buses In-Place Panning

	Basic Strip
	Level Bargraph Rotary Controls and Faders
	Buttons
	Logical Input and Direct Output Assignment
	Stereo Strips
	M&S Stereo Strips


	Creating and Configuring Mixers
	Mixer Configuration Wizard
	I/O Busses Explained
	Input Strip Types
	Internal Return Busses

	Mixer Delay Compensation
	Summary
	Delay Compensation Switching
	Delay Compensation
	Delay Compensation Indicator
	Maximum Delay Compensation
	Outboard Latency
	Delay Chart
	Time Alignment of Recorded Clips
	Recording Bus Returns
	Delay Compensation Detail


	Configuring a Blank or Existing Mixer
	Adding Strips
	Removing Strips

	Mixer I/O Assignments
	To or from physical I/O
	From tracks

	Plug-ins
	Mixer Strip Controls
	Native VS3 Plug-ins
	VST Plug-ins
	External Insert

	Further Mixer Configuration Options
	Mixer Context Pop-up menu


	Dithering Options
	Selected Bus :
	Dither Type
	Word Length
	MT-r
	Noise Shaping
	POW-r

	Mixer Presets
	Default Mixer
	Storing New Mixer Presets
	Removing Mixer Presets
	Saving / Loading Mixer Presets

	Mixer Surround Components
	Speaker Controls
	Joystick Panner
	LFE Level
	Surround Stem select
	Stereo Input Strips.
	Open Surround Control
	Surround Control window
	.Position/Speaker Control
	Surround Panning Algorithm
	Level Meter
	Stereo Surround Control
	Strip and Bus Tools



	13 Strip and Bus Tools
	Strip and Bus Tools
	Eq, Comp/Limiter/Expander
	Difference between Strip Tools and Bus Tools
	Modules
	Display Options
	Linking Strip-Tools controls
	Automation mode switches

	Sections
	Input Level
	Dynamics
	Expander
	Equalizer
	Output

	Common Features
	Input Section
	Dynamics Section
	Expander Section
	Equalizer section
	Output Section
	The Big Graph Window


	Bus Tools
	IMPORTANT! Pre-Anticipation (PA) and Delay Compensation (DC)
	Sections
	Input Level
	Limiter
	Limiter DRC
	Equalizer
	Output
	Main and Input Level Section
	Delay Compensation
	Limiter section
	Limiter DRC Section
	Gain reduction bargraph
	Dynamics bargraph
	Velocity control
	Offset control
	Curve control
	Pre-Anticipation (Lookahead delay) control
	EQ and Output Sections


	Delay Compensation / Pre-Anticipation
	Example
	5.1 Surround Mix Bus using two Bus Tools


	14 Pyramix Mixer Settings
	Mixer
	Level Meter
	Headroom
	Alignment
	Peak and Overload Hold Time
	Decay integration time
	Peak level indicator
	DSD Peak Filter

	DSP Power Saving
	Special Modes
	DSP Time Saving

	Mixer Settings
	Delay Compensation Policy

	Plug-ins Settings
	VST Plug-ins



	Index

